omeewe

BILLINGS USER GUIDE




Information in this document is subject to change without notice. Companies, names and data used in
examples are fictitious.

Copyright ©2025 by InEight. All rights reserved. No part of this document may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express permission of InEight.

Microsoft Windows, Internet Explorer and Microsoft Excel are registered trademarks of Microsoft
Corporation.

Although InEight Billings has undergone extensive testing, InEight makes no warranty or
representation, either express or implied, with respect to this software or documentation, its quality,
performance, merchantability, or fitness for purpose. As a result, this software and documentation are
licensed “as is”, and you, the licensee are assuming the entire risk as to its quality and performance. In
no event will InEight be liable for direct, indirect, special, incidental or consequential damages arising
out of the use or inability to use the software or documentation.

Release 25.5
Last Updated: 26 August 2025

Page 2 of 153 InEight Inc. | Release 25.5



Billings User Guide

CONTENTS

1.1 Getting Started ... 9
1.21Installing Billings ...l 9
1.2.1Billingsinthecloud ... . . . 9
Billingsinthe Cloud ... .. .. . . 9
1.2.2Billings Legacy ... 11
1.2.3 Updating Billings ... . 12
1.3 Billings Configuration ... . 12
1.3.1 Application Configuration ... 12
1.3.2 Utilizing the System Configuration ... 12
1.3.3 Suite Administration ... . 14
1.3.3.1UserManagement ... 14
1.3.3.2Permissions Tab ... ... 16
1.3.3.3System Processes Tab ... ... 17
1.3.3.4 REQIONS ... o 18

1.4 Billings Administration ... ... 18
1.4.1 User Account Management Information ... 18
1O Help MenU .. 21
1.6 Help Options ...l 21
1.6.1 Contact Billings Support ... 21
1.6.2 Verifying Billings Version Info ... 22
1.6.3RefreshCache ... ... .. . 23
1.7 Navigation ..l 23
1.8 Billings Navigation ... . . 23
1.8.1 Navigation Menu ... 23
1.8.2 OK, Apply, and Cancel Buttons ... 25
List/ Grid Modification ... ... 25
1.8.3 Filter Functionality ... 26
Edit Filters .l 27
1.8.4 Utilizing Layout Management ... 28
1.9Data Library ... 30
1.10 Classifications ... 30
1.10.1 Create a new Personnel Classification ... 30
Create a new Personal Classification ... 30
1.10.2 Create a new Equipment Classification ... 32

InEight Inc. | Release 25.5 Page 3 of 153



Billings User Guide

Create a new Equipment classification ... 33
1.10.3 Create a new Material Classification ... 35
Create a new Material Classification ... 35

T AT RESOUICES ..o 36
1.11.1 Create new Personnel resources ... 36
Create a new Personnel resource ... 36
1.11.2 Create a new Equipment Resource ... 41
Create anew Equipment Resource ... 42
1.11.3 Create new material resource ... 44
Create anew material resource ... 44
1.11.4 Createalocation ... 47
Createalocation ... . 47
1.11.5Create anew Division ... 48
Create anew DiVISION ... 48
1.11.6 Create new Company (Client or Supplier) ... 51
Create new Company (Clientor Supplier) ... 51
1.12 Project Management ... ... . . 55
T A3 Rate Tables ... 55
1.13.1 CreatinganewRate Table ... .. ... 55
1.13.1.1 Column Display Options ..., 56
1.13.1.2 Company and Source columns ... 57
1.13.1.3 Personnel Rates ... 57
1.13.1.4 Equipment Rates ... 59
1.13.1.5Material Rates ... 60
1.13.1.6 Lineltem Rates ... 61
1.13.2CopyingaRate Table ... ... . .. 63
CopyaRateTable ... .. . 63
1.14 Manual Rate Imports ... 65
Import rate table file and configure settings ... 65
1.14.1 Importinga Rate Table ... ... . .. 68
Legacy Labor Rate Imports ... ... . 68
1.14.2 Utilizing Mass EditwithaRate Table ... 72
mass edit Rate Tables ... 73
1.14.3 Configuringa Project ... ... . . . 75
1.14.3.1 Configuretab ... . . 75
1.14.3.2 Line-ltem Markupstab ... 78
1.14.3.3CostCodetab ... 80
1.14.3.4 Details/Notestab ... 81
1.14.3.5 Equipmenttab ... 81

Page 4 of 153 InEight Inc. | Release 25.5



Billings User Guide

1.14.3.6 Crewtab ... .. 83
1.14.3.7 Materialtab ... . . 84
1.14.3.8 time sheetOptionstab ... 85
1.14.3.9Work Ordertab ... 86
1.14.3.10Payltemstab ... . . 87
Attachmentstab ... . 88
WBS Structure ...l 89
1.14.4 Platform project association ... 91
1.14.5Managinga Site ... 92
1.14.5.11 Personnel Tab ... . . .. 93
1.14.512 Equipmenttab ... . . 98
1.14.5.13 Materialstab ... . . 98
1.14.5.14 Companies Tab ...l 99
1.14.5.15Contactstab ... ... 100
1.15 TimeSheets Overview ... . . 101
1.15.1 Understanding TimeSheets ... 101
1.15.1.1 Time Sheet StatusRules ... ... 102
Creating a Single Day, Single Projecttimesheet ... 104
1.15.1.2Personnel Tab ... .. . 106
1.15.1.3 CostCode Field ... ... ... . . 108
1.15.1.4 Equipmentand Material Tabs ... 109
1.15.1.5Lineltems Tab ... 109
1.15.1.6 Details Tab ... 110
Creating atimesheetlayout ... ... 112
1.15.2 Creating a Multi-Day, Multi-Project TimeSheet ... 114
Create a multi day, multi projecttime sheet ... 114
1.15.2.7 Personneltab ... .. 116
1.15.3 Creating a Multi Day, Single Project Timesheet ............................ 116
Create a Multi Day, Single Projecttimesheet ... 116
1.15.3.8 Equipment and Materialtab ... 119
1.15.39Lineltems Tab ... . 120
1.15.3.10Detailstab ... 122
Creatingatime sheetlayout ... 123
1.15.4 Copying an Existing Timesheet ... ... ... 126
Copy existing timesheets ... 126
1.15.5 Importinga Timesheet ... . . . 129
Importatime sheet ... 129

1 A6 LEMS 131
1.16.1 Creatinga LEM .. . . 131
Createa LEM .. . . 132

InEight Inc. | Release 25.5 Page 5 of 153



Billings User Guide

T AT INVOICES ..o 135
1.17.1 Creatingan INnVoiCe ... 135
Create an INVoICe ... 136
Create @anNeW INVOICE ... 137
1.18 Managing Mass Changes ... 137
1.18.1 Retro Rate Adjustment ... 138
Start a Retro Rate Adjustment ... 138
1.18.2 Generate Timesheet Line ltems Wizard ... 141
Generate time sheetlineitems ... 141
1.18.3 Viewing Timesheet Locks ... 148
Viewtime sheetlocks ... 149

T 1O REPOMS . 151
1.19.1 Report EXport OptionS ... 151
1.19.1.1 Print Preview ... 152

Page 6 of 153 InEight Inc. | Release 25.5



Billings User Guide

STEP BY STEP PROCEDURES

Billingsinthe Cloud ... . . . 9
List/ Grid Modification ... ... 25
Edit Filters 27
Create a new Personal Classification ... 30
Create a new Equipment classification ... 33
Create a new Material Classification ... 35
Create anew Personnelresource ... 36
Create a new Equipment ResSoUrce ..., 42
Create anew material resource ... 44
Createalocation ... . 47
Createanew Division ... .. 48
Create new Company (Clientor Supplier) ... 51
CopyaRate Table ... 63
Import rate table file and configure settings ... 65
Legacy Labor Rate Imports ... 68
masseditRate Tables ... . 73
Creating a Single Day, Single Projecttimesheet ... 104
Creating atimesheetlayout ... . .. . . 112
Create a multi day, multi projecttime sheet ... ... ... 114
Create a Multi Day, Single Projecttimesheet ... 116
Creatingatime sheetlayout ... 123
Copy existing timesheets ... 126
Importatime sheet ... 129
Createa LEM . 132
Createan InvoiCe ...l 136
Createanew INVOICe ... 137
Starta Retro Rate Adjustment ... 138
Generate time sheetlineitems ... .. .. 141

InEight Inc. | Release 25.5 Page 7 of 153



Billings User Guide

View time sheet loCKS ... 149

Page 8 of 153 InEight Inc. | Release 25.5



Billings User Guide 1.1 Getting Started

EXERCISES

1.1 GETTING STARTED

1.2 INSTALLING BILLINGS

1.2.1 Billings in the cloud

Open the application from within InEight Platform. Platform’s primary function is to let you connect
and share data between all InEight applications involved in managing a project. This allows project
management workflows to pass between jobsite, field office, and front office seamlessly in a consistent

and standardized user interface.

BILLINGS IN THE CLOUD

1. Select a project, and then select Billings from the Main menu.
If you are using the legacy Billings application, click the installer download link distributed to you
via email by your local administrator.

Open InEight.Billings.Launcher?

https://billings-demo.hds.ineight.com wants to open this application.

Always allow billings-demo.hds.ineight.com to open links of this type in the associated app

_ Design
Quantity forecasting X
Open InEight.Billings.Launcher ncel
Engineering

| Billings

\ Launch InEight Billings

The Billings Launcher must be installed to run InEight Billings. If it is your first
launch, or you need the latest version ef the Billings Launcher select the
download button below.

Workspaces

Project library
This dialog will close in 28 seconds

2. If you are using Billings for the first time, select Download, and then select Next (or Open) to
start the one-time Billings Launcher download.
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Billings Launcher

Downloading...

About 3 minute(s) remaining

- Cancel
240104 .1

“H InEight Billings Launcher Setup

Welcome to the InEight Billings Launcher
Installer Wizard

Let's get started on installing InEight Billings Launcher on
your computer, Click "Next™ to continue or "Cancel” to exit.

Back | Miext Cancel

3. If prompted, complete the log in to the applications through your company’s log in portal

4. The InEight Billings launch page opens, and you can begin using Billings in the cloud.

Page 10 of 153 InEight Inc. | Release 25.5



Billings User Guide 1.2 Installing Billings

InEight Billings
DEMO (PTR2) [

b

ES
L
(=]
]

[OMCAR: Sl e

20240311223 PM  Status: Ready mt2dmoscussg\DTC2-MT2-DMO-SCUS-DB-8Bilings(B) 2432406501 .

1.2.2 Billings Legacy

The Billings application is launched by double-clicking the application icon placed on your system
desktop by the installer, after completing the application download via the URL provided to you by
your administrator. After the application is launched, the login dialog box may open if you have access
to multiple companies, otherwise the application will start.

Wleaga If this is the first time you are running Billings, you will be prompted to complete the
log in process using your company’s log in portal.

Account:
nEight
(5) BILLINGS Password:
Company: | Bilings Internal N i

Verify that the company you are logging into is correct, and then select OK.

InEight Inc. | Release 25.5 Page 11 of 153



1.3 Billings Configuration Billings User Guide

When a new version of Billings is available, by your system administrator, you will get a message when
you attempt to log into the system. Click Download to update the version. You will not be able to
access Billings without installing the updated version.

1.2.3 Updating Billings

When a new version of Billings is available, the system will display a message indicating that an update
is available when you attempt to run the application. Click the Download link on the prompt to launch
your browser, and then click Launch Billings to update the version. You will not be able to access
Billings without installing the updated version.

1.3 BILLINGS CONFIGURATION

1.3.1 Application Configuration

The Billings application is configured to meet your specific business requirements, which is typically
accomplished when Billings is initially configured by the implementation specialist. However, multiple
options still exist for the system administrator to adjust the application as business needs change over
time.

Configuration and system maintenance include any of the following functions:
* Drop-down value lists

e Custom field definitions

e System integration schedules

* Billings mobile application rendering configuration

Me)g= The term maintaining in this context means adding new values, editing existing values, or
removing no longer needed values.

1.3.2 Utilizing the System Configuration

Go to Suite Administration > System Configuration.

ey Only System Administrators will have access to configure the application.
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snagement

T,H' System Configuration

‘T Master Data Uploads

The System Configuration page opens as a new tab with the Field Setup sub-tab selected. This Field
Setup tab lets the Administrator create custom fields for any entity which contains a Details tab.
Custom fields are primarily created for master data-related entities, found in the Data Library menu,
but can also be used for the Projects and Timesheets.

To add a new custom field, click the Add Row ribbon bar button. The following entities support custom
fields:

e Cost Code — Global

e Personnel

» Cost Code — Project Specific
* Project and WBS items

e Personnel Classification
e Material

e Equipment

e Material Classification

* Equipment Classification
* Region

e Division

e Time Sheet

InEight Inc. | Release 25.5 Page 13 of 153



1.3 Billings Configuration Billings User Guide

e Company

Using the drop-down list, you can select which of the Billings entities to add a custom field to and then
type in the name for the new custom field in the Name column.

You can click the drop-down list for the Type column and then select how you want the data displayed
(such as, Date, Text, MRU Text, Personnel, Yes/No, Integer, or Decimal).

For certain entities, such as Project, you can also configure the “Scope”, that is, whether the custom
field applies to the entire project entity, to the Project only, or to the WBS items contained within the
project.

To delete any of the custom fields, you can highlight the item and click the Delete Row(s) button from
the home ribbon menu.

When complete, you can click the Apply button, or to exit the dialog box, you can either click the OK
button along the bottom right-hand side to save your changes and exit or click Cancel to exit without
saving changes.

1.3.3 Suite Administration

1.3.3.1 User Management

To access user information from the Main menu, click Suite Administration > User Management.Only
an Administrator can access the Suite Administration or the User Management functionality.
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InEight Billings

Eﬂ Lser Management

The User Management tab opens listing all users in the system.

InEight Billings

= o X
HOME DEMO (PTR2) [0
@
= = C 2%  xuw & X
B Paste
Add Row Delete Refresh  Undo Layout Close
Row(s)

User Management ©

oﬂ The security manager allows you to add, edit, and delete users. Double clicking on a user will allow you to set their password and edit their permissions.

User Name Name

Status
"0 Qe s

Active

Active

Active

Active

Active

Active

oﬁ User Management Active
= Active
{4 Layout Management Active
Active

Iy — petve
Active

Tl System Corfiguration Active

T Master Data Uploads

2024-03-14 11:55AM  Status: Ready mt2dmoscussql\DTC2-MT2-DMO-SCUS-DB-18Billings(B)  24.3.24065.01  .:

When new users are added through Platform, they are automatically created in Billings as a standard
user, provided the appropriate suite and application access is granted through the InEight suite Roles
and Permissions. User authentication is performed through the customer’s Active Directory or Google
security validation, including any MFA requirements, therefore no Billings-specific password is
required. Once a user exists in the system, the Administrator can enlist the user in Billings user types
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and groups, as well as grant the user access to one or more regions. You can open a user record to
define its settings by double clicking on the user from the list.

@) User

General Permissions System Processes Mobile Project Security

® User Name:

Name:
E-mail:

Status: Active

Confirm Passwaord:

Enforce password policy
Enforce password expiration

User must change password at next login

Created:
Modified:

\{e3j = You must have a status of Active, be a member of at least one security role, and
have access to at least one Region before the system will allow you to complete the

login process.

1.3.3.2 Permissions Tab

As an administrator of the system, you control the type of functional access the user will have and can
restrict access to data by region utilizing the Permissions tab. Roles allow you to control which
functions of the system the user will be able to utilize. More than one Role can be associated with a
user. Regions allow the Administrator to control which data in the system the user will be able to see
or operate on, as constrained by the Role membership defined above.
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General Pemissions System Processes Mobile Project Security

User permissions are determined by both the roles assigned to them and the regions where those roles are effective.

Rales
Remove existing user roles or add user roles from the available roles list.
User Roles: Available Roles:
.
Certffication Power User
Certfication User
<< Add Certfication User (Read Only)
Remove =3 Expanded Process Editing
Expanded Project Editing
Expanded Timesheet Editing
Imports User il
Regions
@ Remove existing user regions or add user regions from the available regions list.
User Regions: Available Regions:

<< Add

0K Cancel :
1.3.3.3 System Processes Tab

On the System Processes tab, you can control the types of imports, exports, and adjustments the user
can execute. To grant access to any process, check it off using the check box located next to the
process description.
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General Permissions System Processes Mobile Project Security

Granting system process to user will allow userto perform Export, Import, or

Adjustment.
Processes
Type Description
Bilings Inter . Audit Trail Maintenance -

Adjustmerts | Actuals Task Transfer Adjustment
Adjustmerts | Retro Rate Adjustment

Imports Classffication Import

Imports Equipment Import

Imports HardDollar Project Import

Imports LEM Import

Imports Material Import

Imports Personnel Import

Imports Project Import

Imports Rate Table Import

Imports Timesheet Import

Imports Action Group Integration Import
Imports Action Integration Import

Imports Application Integration Import
Imports Control CBS Integration Import
Imports Control Payltems Integration Impaort
Impaorts Craft Integration Import

Impaorts Employee Integration Import
Impaorts Equ Category Integration Import
Impaorts Equipment Integration Import
Imparts Equipment Type Integration Import
Imparts Extemal Code Value Integration Import

TR P T N WY R,

Select the OK or Apply button to save any changes. This will return you to the main User Management
tab.

1.3.3.4 Regions

Regions are used to manage what users can see within Billings. If a user has permission to a Region,
they can see all resources, rate tables, projects, time sheets, LEMs, and Invoices associated to the
Regions they have permission for.

1.4 BILLINGS ADMINISTRATION

1.4.1 User Account Management Information

There are thirteen user roles or groups in Billings and five specialized roles for more security control. A
single application user can be a member of one or more roles, which determines the functional areas
of the application that they have access to. The following defines the thirteen groups:
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User Role Definition

Administrator The user designated as the technical application lead within the
system. This role manages the application security and users
interaction with the system through user groups. Members of this
group can perform all functions on all pages.

Power User User designated as the highest privileged user for their own region.
This role manages the setup of Billings and how it will affect reporting,
payroll, and integrations, and ensures the application is aligned to
client requirements.

Report Administrator User who has a deep understanding of Billings as well as the technical
knowledge to build reports using the Billings report manager. This role
can be used as a standalone for someone who only needs to access
the report manager to build reports or can be used in addition to any
other role that needs access to the report manager.

LEM A user who can approve LEMs. This role is unable to create, edit, or
Approver/Reviewer delete LEMSs, but they can complete all functions (except crediting an
invoice) that take place after a LEM is created

User User designated as having a higher skill set with capabilities to set up
information in Billings as needed.

Time sheet Entry User designated as having limited involvement in setting up
information in Billings.

User (No Rates) User level access to Billings except for access to rates information on
rate tables, time sheets, and reports.

Supervisor (View User designated to have view only and report generating rights in the
Only) application.
Imports User User who is monitoring or performing imports into Billings. This role

can be used standalone for someone who only needs to access these
functions or can be used in addition to any other role that needs access
to perform imports.

Certification Power User who manages the overall tracking of certification information,

User such as someone in HR or a corporate safety officer. This role can be
used standalone for someone who only needs to access the
certification module or can be used in addition to any other role that
needs access to the certification module.
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User Role Definition

Certification User User who only requires access to the certification information but is not

(Read Only) authorized to make changes, such as a Project Manager or
Supervisor. This role can be used stand alone for someone who only
needs to access the certification module, or can be used in addition to
any other role that needs access to the certification module.

Project Accountant User who manages running data exports and adjusting exported data.

Specialized User Role Specialized User Role Definition

Share Layouts Gives a user the ability to share their
personalized layouts with other users. The
members of this role cannot administrate
layouts for others, only their own.

Expanded Time sheet Editing Gives a user the ability to edit or delete export
batches (including LEMs and Invoices) created
by other users, if the user has the right to
create one or more Export batches
themselves. This means they will be able to
edit/delete batch results created by other users
for types that they have access to already.
Note that this functionality is already available
to all Power Users and Administrators. This
specialized security role simply gives the ability
to edit or delete export results batches created
by other users, and removes Approval Status
restrictions, elevating these rights to be
equivalent to the Power User role (but NOT the
Administrator role).

Expanded Export Editing Gives a user the ability to edit or delete
timsheets created by other users. This means
they will be able to edit/delete timesheets
created by other users . Note that this
functionality is already available to all Power
Users and Administrators. This specialized
security role simply gives the ability to edit or
delete timesheets by other users, and removes
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Specialized User Role Specialized User Role Definition

Approval Status restrictions, elevating these
rights to be equivalent to the Power User role
(but NOT the Administrator role).

Restricted Export Editing Gives a user the ability to edit or delete export
batches created by other users, if the user has
the right to create one or more Export batches
themselves (that is, they will be able to
edit/delete batch results created by other users
for types that they have access to already).
Unlike the Expanded Export Editing above, this
role does NOT allow users any added rights
over the Approval Status.

Mobile User (for use with the standalone User cannot use the desktop system, but can
client only) capture personal time sheets using the mobile
client

Mobile Foreman (for use with the standalone User cannot use the desktop system but can

client only) capture attendance and time sheets for
themselves and their crews using the mobile
client. This only applies to stand-alone mobile
customers.

1.5 HELP MENU

1.6 HELP OPTIONS

1.6.1 Contact Billings Support

If Billings Support is needed, click the Help icon and select Contact InEight Billings Support.
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[ Contact InEight Billings Support

@ System Info

C Refresh Menu

A blank e-mail to support@ineight.com will be opened using the default email application installed on
the desktop. You can enter in a full description of the issue including the following details:

e What user is having the issue
» Screenshots of the error and the window it is occurring in

¢ The time sheet #, LEM# and/or the Invoice #

e If it’s an error with a report, what report it is, and what parameters were used when requesting the
report.

e User contact information (e.g., Phone number, e-mail address)

Unitithed - Message (HTML)
Message Insert Options Format Text Review Help @ Tell me what you want to do
_—

i ] Arial

1.6.2 Verifying Billings Version Info

To find the application version information for Billings, got to Help > System Info.

The following window appears providing details on the version and the Billings website link.
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Aot el aght Ballngs O

Click OK at the bottom of this window to exit.

1.6.3 Refresh Cache

The Refresh Cache function allows the users to trigger a complete refresh of the locally cached
reference data. This includes, named resources, list of vendors and suppliers, classifications (trade and

craft) and category and type equivalent in Platform.

1.7 NAVIGATION

1.8 BILLINGS NAVIGATION

1.8.1 Navigation Menu

When opening Billings, the navigation list is collapsed. To view the menu items for navigating through

Billings, there are 2 options:

Option 1: Expand the menu by clicking the double arrow at the top left corner of the Billings window,
as shown in the image below. This will expand the menu to provide the name for each menu grouping;
you can then click the down arrow to open the list of items within each grouping (alternatively, click

the up arrow to collapse the grouping list).
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InEight Billings (Billings Internal)

Personnel

Equipment
InEight Billings (Billings Internal)

InEight Billings (Billings Internal) = Material

HOME

v

Personnel

Equipment
Material
mpanies
EI Cost Codes
@ Regions
[Eﬂ Divisions
@ Locations

= | Certifications

" %
£ o
[
3
I
& :
_
-

@&l
&

n

{@o
n
@o

Certification Types

(D)
O

Option 2: With your mouse, hover over the icon to see the grouping name, then click the desired icon
to provide you with the list of the items within that grouping.
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InEight Billings (Billings Internal)

HOME

=)

R |

Project Administration

e =T 29

[y

n
oo

OND

1.8.2 OK, Apply, and Cancel Buttons

You will notice the OK, Apply, and Cancel buttons are available on most of the Billings data
maintenance pages. Pressing Cancel exits the page and discards any changes that you have made. The
functionality of the OK and Apply buttons differs slightly depending on whether you are creating a new
record or modifying an existing record. In both cases, pressing either of the buttons saves your changes
to the database. However, if you are adding a new record, pressing Apply not only saves the data to
the database, but also refreshes the page to let you enter yet another record. Clicking OK saves the
data but then exits the page. This is to maximize the data entry speed by allowing you to add multiple
new records without needing to exit the page.

LIST / GRID MODIFICATION

If there are columns that you do not require, you can remove them with the following steps:
1. Select the column header by clicking and holding the mouse button down.
2. Drag it downwards until you see an “X” appear.

3. Drop it by releasing the mouse button and the column will be removed.
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4. Repeat this step for all the columns you would like removed.

Perform the following steps If you would like to retrieve a removed column or any other columns
which may not be visible by default.

1. Right click anywhere on the column header row to bring up a pop-up menu.
2. Select Column Chooser. A Customization window opens.
3. Click and hold the mouse button on the field you require.

4. Drag and drop the field to the column position where you would like it to appear on the grid.

feyi=2 You have to drop it in the header section of the page.

1.8.3 Filter Functionality

When opening a page within Billings which contains a grid, an auto-filter feature is available. This
feature is available with pages containing the following data:

e Timesheet

e LEM

* Invoice

e Project

* Rate Table

e Company

e Cost Code

e Equipment

e Personnel

® Region

* Division

Each of these pages includes a row directly under the column header row dedicated to filtering. In this

row, you can narrow the list by entering in specific criteria (e.g.., T/S Number, LEM number, Project
Name, etc.). A filter icon appears in each column header when the mouse is placed over the column. If
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a filter is activated, the icon is highlighted. If the filter icon is clicked, the filter can be automatically
adjusted by selecting from the options of Custom, Blanks, or Non-blanks.

EDIT FILTERS

In the bottom right corner of the page, you can select the Edit Filter button to adjust the default filter
settings.

1. Select Edit Filter.

Edit Filter

2. Click the And button to select any of the following options:
e And

e Or

e Not And

e Not Or

Filter Editor b

¢ 8 8 8 3
s o

= Cancel AR

3. Click the Plus button beside the And button to select one of these options:
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¢ Add Condition

e Add Group
ard

Within this row, each character can be edited.

Another option when retrieving data is the Quick-Type feature. This lets a user open an existing list and
begin typing in the first characters of the word. Billings will automatically begin to filter the list by
these characters. The example below is searching LEM Numbers by the letter s. Billings will display all
LEMs beginning with this character.

1.8.4 Utilizing Layout Management

To access the Layout Manager from the Main menu, select Suite Administration > Layout
Management.

e Only System Administrators will have access to configure the layouts for other
users.
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£
2 User Management

[T Lavout Management

REpart Management

The Layout Management page appears. The Layout Management tool is user specific. This means any
layouts listed in the window are layouts the logged-in user has previously created and saved through
the various page’s Layout ribbon bar functionality, or layouts that have been shared with this user.

From the General tab, you can view the available layouts and delete any layouts that are no longer
required. To delete a layout, highlight the line item by clicking on it, then click the Delete Row(s) icon
located on the ribbon menu.

Click the View tab to view the basic outline of the selected layout. Any changes made to the layout
from this preview will not be saved; this is strictly for viewing purposes. All changes must be done from
the page to which the layout applies.

el g=n If you are viewing a time sheet layout, you must be in the time sheet page to change the
layout
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Click Apply or OK on the bottom right to exit the Layout Management window.

1.9 DATA LIBRARY

1.10 CLASSIFICATIONS

1.10.1 Create a new Personnel Classification

Billings will receive all operational resources associated to personnel, including Trade and Craft lists,
from InEight Platform. Both Trade and Craft will populate the Personnel Classification library. However,
it may be necessary or desirable to add additional classifications or organize the Trade and Craft items
received from Platform into a deeper structured format.

CREATE A NEW PERSONAL CLASSIFICATION

1. Open the Data Library menu item and select Classifications > Personnel.
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Copy
H cut

Refresh ) . — Undo  Show Active
(B Paste Speda Only
P Regions Personnel Classification ©
Equipment |©  add | Remave | |Q,  Find

» | .KC_Carpenter 1 (KC-CP1)
» | KC_Carpenter 2 (KC-CPZ)
» | .KC_Carpenter 3 (KC-CP3)

Lo

Material

Personnel » | KC_Carpenter 4 (KC-CP4)

» | .KC_Labourer - Intermediate (KC-LEIN)
Equipment » | KC_Labourer - Junior (KC-LBIR)

» | .KC_Labourer - Senior (KC-LBSR)
Material » | KC_Superintendent (KC-SUP)

» | .KC_Welder - B Pressure (KC-WDBP)

2. The Personnel Classification tab appears. This tab lets users view all records and create new or edit
existing personnel classifications that were configured for billing purposes.

3. Right click the Personnel (Emp) icon and select Add Classification from the dialog box or click the
Add button located just above the list of classifications.
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S Personnel (Emg)

4. On the General tab, enter the Description and Code. The Status field automatically defaults to Active
and the Parent field is grayed out and will automatically default to the appropriate parent node from

the classification tree.

KC_Carpenter 1 (KC-CP1)

5. You can create classification structures by dragging and dropping individual classifications into other
classifications, building up a tree or folder-like structure. This lets you group classifications.

6. Click the Details tab. This section is used to capture custom field values.

7. Click Apply or OK at the bottom of the page to save your changes.

1.10.2 Create a new Equipment Classification

Billings will receive all operational resources associated to equipment including the Equipment
Category and Types lists from Platform. Both Category and Type will populate the Equipment
Classification library. However, it may be necessary or desirable to add additional classifications or
organize the Category and Type items received from Platform into a deeper structured format.
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CREATE A NEW EQUIPMENT CLASSIFICATION

1. To create a new Equipment classification, open the Data Library menu and select Classifications >
Equipment.

2. The Equipment Classification tab appears. This tab lets you view all records or create new and edit
existing equipment classifications that were configured for billing purposes.

e

3. Right click the Equipment icon and choose Add Classification from the menu or click the Add button
located in the ribbon menu above.
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Full Collapse
Expand To Level

Collapse To Level

4. In the General tab, enter the Description and Code.
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5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization's requirements.

6. Click Apply or OK at the bottom of the page to save your changes.

1.10.3 Create a new Material Classification

CREATE A NEW MATERIAL CLASSIFICATION

1. Go to Data Library > Classifications and then Material.

Personnel

Equipment

: Material

Personnel

Equipment

Material

2. The Materials Classification tab appears. This tab lets you view and edit all material classifications
currently in the system.

3. Right click the Material and select Add Classification from the resulting menu or click the Add
button located in the page’s ribbon menu.
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®  Add % Remove | Q Find

Mame Code Type
| Materal Mat

» | Piping FIP

» | Structural STR

» | Blectrical ELE

» | Civil civ

» | Ltiity Poles UTLPOL

- MﬁTCﬁT
(¥)  Add Classfication

% Delete Classification

—— Full Expand

+

3 Full Collapse
Expand To Level

Collapse To Level

4. In the General tab, enter the Description and Code.

5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization requirements.

6 . Click Apply or OK at the bottom of the page to save your changes.

1.11 RESOURCES

1.11.1 Create new Personnel resources

Billings will receive all operational resources associated to personnel from the Master Data Library
within Platform.

CREATE A NEW PERSONNEL RESOURCE

1. To create an additional resource, that will be used for purposes of customer billing only, go to Data
Library > Resources > Personnel.
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InEight Ballangs (Billings Intemal)
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Personnel Resources  ©

2. The Personnel Resources tab appears. Click the Add Row icon on the ribbon bar.

(—_xCe-- 3 B X

e

1.11 Resources

3. The Personnel window opens. Enter the employee’s last and first name in the appropriate fields.

4. Assign a personnel code in the Code field.

e} g= The Code must be unique within the database. As a best practice use your organization’s

internal code for the individual.
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5. Click the drop-down arrow on the field labeled Source. This field lets you label the resource as a
subcontractor, employee, third party or any other description previously set up by the system
administrator.

L OE

6. Click the ellipsis (three dots) icon in the Billing Classification field. A Classification dialog box appears.
Select the Employee’s classification by double clicking on it.

J{e =0 You can use the Search feature at the top of the pop-up to search for the classification
using either the name or the code.
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7. The Cost Classification field will replicate the classification chosen in the Billing Classification field.
However, this can be changed if required by clicking on the ellipses icon in the Cost Classification field
and updating accordingly.

8. Click the ellipses icon in the Company field. This field lets users assign a worker to the company for
which they work for.

As an example, if the employee works directly for ABC Company, select ABC Company as the company
name. If the employee is a subcontractor working for Al’s Contracting Services, select Al’s Contracting
Services as the company the worker works for.

9. Scroll through the list or use the Search field and type in the name of the company the worker is
working for. Double click to select the appropriate company.

Stabs At EdtFite
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10. Click the ellipses icon on the Region field. A Region window appears. Scroll through the list or type
in the region name in the Search field. This associates the worker with a default region.

{Q Riegeon o x
?
St e Sths T
o CE .
aberta AB ACtve
Britigh At
B, F P g At
Status Actve it Filter

Refresh X Caniel

11. Click the drop-down arrow of the Payroll Status field and select if the person is On Payroll or Off
Payroll. The value selected here is used to determine if this person’s hours should be sent to the
payroll system.

Payvrol Stabs:

Sbatus: Off Payrol

Shifft Rotabon:

12. Click the drop-down box on the Shift field. A selection of Day, Night, or Other shift appears. Select
the default shift type the employee typically works.

AleJg=0 You can always indicate the actual shift worked when time is captured for this worker on
a time sheet. This often happens when a worker is temporarily working a different shift
from what their master personnel record is set to.
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Shift Rotabon;

P Rig LAy

1.11 Resources

13. Shift Rotation is not required but can be added if there is a need to include this information on
Billing reports. Click the drop-down box on the Shift Rotation field. A selection from the Options
window appears. Select the default Shift Rotation the employee typically works. Shift Rotations are

defined in the Options menu under Drop-Down List Setup > Shift Rotation Type.

14. Click the Details tab. This section is used to capture custom field values. Populate any custom fields

per your organization requirements.

1.11.2 Create a new Equipment Resource

Billings will receive all Operational Resources associated to Equipment from the Master Data Library

within Platform.
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CREATE A NEW EQUIPMENT RESOURCE

1. To create an additional resource that will be used for purposes of customer billing only, go to Data
Library > Resources and then Equipment.

= InEight Billings (Billisgs Internal)

e

2. The Equipment Resources tab appears. click the Add Row icon on the ribbon bar.

c, 5 B’ X

2 # # @ ¥ -

3.The equipment setup window opens. Enter in the name of the unit in the Name field.
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4. Enter in the unit number for the piece of equipment in the Unit # field and the unit code in the Code
field. While these can be the same, they do not need to be. The Unit # is typically matched to the
equipment placard, while the code is typically matched to that equipment’s accounting code
designation.

5. Click the drop-down arrow on the Source field. This field lets you label a piece of equipment as
belonging to an operator, owned, third party, subcontractor or any other custom description
previously set up by your system administrator.

ol e
e il T T
Bl Clscmfiea=s "
“ost ClassScatio

TS -
LB

g

e =y .

6. Click the ellipses (three dots) icon in the Billing Classification field and the Cost Classification field. A
Classification window appears. Select the unit’s classification by double clicking on it.

W[eJ= You can use the Search feature at the top of the pop-up to search for the classification
using either the name or the code.
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7. The Cost Classification field will duplicate the classification chosen in the Billing Classification field.
However, this can be changed by clicking on the ellipses icon in the Cost Classification field and
changing it as required.

8. Click the Details tab. This page is used to capture custom field values. Populate any custom fields per
your organization’s requirements

1.11.3 Create new material resource

CREATE A NEW MATERIAL RESOURCE

1. To begin creating new material, go to Data Library > Resources > Material.

Infight Billings (Sdlngs Internal)

&

2. The Material Resources tab appears. click the Add Row icon on the ribbon bar.
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3. The Material window opens. Enter the material Name and Code.

4. Click the drop-down arrow on the field labeled Source. This field lets you label a piece of material
using one of the user-defined Material Types.
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5. Click the ellipses (three dots) icon in the Billing Classification field and the Cost Classification field. A
Classification window appears. Select the material’s classification by double clicking on it.

e = You can use the Search feature at the top of the pop-up to search for the classification
using either the name or the code.

6. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization’s requirements.
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7. Select Apply or OK at the bottom of the page to save your changes.

1.11.4 Create a Location

Locations are used to help in tracking of labor and equipment when they’re not assigned to a project.

CREATE A LOCATION

1. To create a location, go to Data Library > Location.

2. The Locations tab appears. Click Add Row in the ribbon bar.
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3. Enter the location description in the Name field and the location code in the Code field.

Y Location

St

e

Created

Mcckfied:

4. Click Apply or OK at the bottom of the page to save your changes.

1.11.5 Create a new Division

CREATE A NEW DIVISION

1. To create a new division, go to Data Library > Division.
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InEight Billings (Billings Internal)
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Field Construction

Equipment o
Pipeline
P Small Projects
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3. The Division window appears. Fill in the Name and the Code fields. Both are mandatory.
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ey = Divisions must be unique within the database.

Y Division

General Detail

[m ";_ Mame:

Code:
Status: Active -
Motes:
Created:
Modified:
2K Cancel Apply

4. The Status field will automatically default to Active. Enter any notes pertinent to the division in the
Notes section.

5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization's requirements.

6. Select Apply or OK, located at the bottom of the page to save changes.
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a2 Clicking Apply saves the changes and opens a new setup window, allowing you to
quickly make another entry. Clicking OK will save the changes and close the setup

window.

To view the Divisions tab and all divisions that have been set up, refer back to the steps above, where

you opened the Division tab.

legg= Any ribbon menu, where there is a Send To function, lets you send the contents of
the active tab to Excel.

The available columns on the Divisions tab are:

* Name
e Code

e Status

Wlean= If there is a column header that is not currently in view when the page is open and
you would like to see it, right click any column header, and select Column Chooser.

1.11.6 Create new Company (Client or Supplier)

Project related vendors are integrated from the Assigned Vendors in Platform. If additional companies
need to be added that have not been automatically created from the Assigned Vendors in Platform, a
new company (client, supplier or vendor) can be created with the following steps.

CREATE NEW COMPANY (CLIENT OR SUPPLIER)

1. Go to Data Library > Company.
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3. Enter the company name in the Name field. Enter the applicable code in the Code field. Click the
drop-down box in the Type of Relationship field. Select whether the company is a Client, Supplier or
other description previously specified by your system administrator.
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4. The Status field will automatically default to Active. Enter any notes pertinent to the company in the
Notes section and then click the Address tab. Enter the necessary information for the primary address
as listed. You can use the arrow keys or Tab key on your keyboard to move between fields.
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5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization's requirements.

6. Click the Append icon at the bottom, left of the page to add another address. If you need to remove
an address card, select the one to be removed, then click the Delete icon.

7. Continue the same steps to enter details in the Contact, Phone and Details tabs. When ready, click
Apply or OK at the bottom of the page to save your changes.

1.12 PROJECT MANAGEMENT

1.13 RATE TABLES

1.13.1 Creating a new Rate Table

A rate table consists of personnel, equipment, material, and line item rates for premiums and
allowances, as well as other rate exceptions. A rate table must be created and associated with a
project prior to any billable work being LEM’d or invoiced for that project. A single rate table can be
used by one or multiple projects and you can add a rate table to a specific project WBS item.

1. Go to Project Administration > Rate Tables.

£ st

1] Budgets

E Commitments

Rate Tables

a
—

=]

2. The Rate Tables tab opens. You can select any rate table to modify, or you can create a new rate
table by clicking the Add Row icon on the ribbon bar.
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3. In the resulting new rate table tab, enter the name for the new rate table in the Name field. In the
Code field enter the new code. This can be a numeric value or an abbreviation that the rate table goes
by.

4. Select the appropriate region the rate table belongs to.

ey

5. The Status field automatically defaults to Active. Enter any notes pertinent to the rate table in the
Notes section and then click Apply to create the rate table

1.13.1.1 Column Display Options

The Column Display Options button lets you show or hide columns by going to Rate Tables > Selecting
a rates table, and then selecting or deselecting each shift column from the Column Display Options
button from the ribbon menu. By default, at least one item needs to be selected. If all items are
deselected, the drop-down will default to show day shift for Personnel, or Type 1 for Equipment.
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Row(s) - Options ~
Show Rate Code
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Rate Tables Rate: *DEMO  © Show Customer Class Code
General Personnel Rates Equipment Rates Material Rates Line Item Ratgs ./ Show Day Shift
v Show Night Shift
Edit your personnel rates here. By default, the most current rates for each dassiffc
To view the rates that were in effect on different dates, change the effective datd. _, Show Other Shift

Show rates effective as of: | Jan-22-2025 -

1.13.1.2 Company and Source columns

The Company and Source columns give you flexibility when working with different companies, roles or
resource types. These columns are listed in the personnel, equipment, material, and line items tabs of
the rate table and allow you to set different rates based on what role is performing the work or where
the resource comes from. For example, if rates differ between companies for the same role, where a
subcontractor charges $30/ST hour, and an employee charges $25/ST hour for day shift, and $27/ST
hour for night shift, you can use the Company and Source columns in the rate table to define those
rates without having to create separate rate tables.

Rato Tablos Rato: Labor 12 @

Ftes  Egupment Fstes  blgterisl Fates  Line bem Flates

Example Archtect

1.13.1.3 Personnel Rates

In the same new rate table tab as above, click the Personnel Rates tab to start entering personnel rate
information.
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By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.

To add a new personnel rate record, click the Add Row icon located in the ribbon bar. If you wish to
delete a record, select it by clicking it once, and then click the Delete Row(s) icon located in the ribbon
bar. Click the drop-down list or the ellipses (three dots) icon under the Classification column and select
the classification being assigned to the rate record.
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Meyg= Optionally, Billings supports rates for individual resources by classification. For example,
John Smith working as a skilled laborer can be billed out at rates different than the

standard skilled laborer rates. If you choose to enter a rate for an individual in the
classification selected, click the drop-down list under the Resource column, and then
select the individual assigned to the rate record.
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Select the Effective Date of the rate record (that is, when does this rate take effect) and enter in the
rates to be used for the different earnings class by shift (i.e., Straight Time, Overtime, Double Time,
Double Time and a Half, Travel Time, LOA, and Day). Repeat these steps to add another classification to
this rate table.

1.13.1.4 Equipment Rates

To start entering equipment rate information for the rate table you have open, click on the Equipment
Rates tab.

HOME DEMO (PTR2) [

(3 Copy -
= = C : X Cu [z O mE X
B Paste
Add Row Delete Refresh S Undo SendTo MassEdt Show Rate Layout Close
Row(s) < Code .
Rate Tables Rate: EX1 ©
General Personnel Rates Egquipment Rates Material Rates Line tem Rates

Edit your equipment rates here. By default, the most current rates for each classification are shown.
To view the rates that were in effect on different dates, change the effective date.

Show rates effective as of: | Oct-31-2024
Classffication Resource Eff. Date Each Hours Days Weeks
e e

Spyder Crane (15-12) Aug-01-2023 - 100.00 1000.00 6000.00

Tank - 640 L Fuel (38-02 Aug-01-2023 50.00 300.00

Record 10f 2 < R

OK Cancel Apply

By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.

To add a new equipment rate record, click the Add Row icon located in the ribbon bar. If you wish to
delete a record, select it by clicking it once, and then click the Delete Row(s) icon located in the ribbon
bar.

Click the drop-down list or the ellipses icon under the Classification column and select the classification
being assigned to the rate record.
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[\[e3g2 Optionally, Billings supports rates for individual resources by classification. For example,
JD Backhoe operating as an excavator can be billed out at rates different than the

standard backhoe rates. If you choose to enter a rate for an individual piece of
equipment in the selected classification, click the drop-down list under the Resource
column, and then select the individual piece of equipment assigned to the rate record.

Select the Effective Date of the rate record (that is, when does this rate take effect) and enter in the
rates to be used for the different earnings class by shift (i.e., Hours, Days, Weeks, Months and a
Standby and Each). Repeat these steps to add another classification to this rate table.

1.13.1.5 Material Rates

To start entering material rate information, click on the Material Rates tab under the Rate table tab

you are in.
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Add Row Delete  Refresh * Unde SendTo  Mass Edit Show Rate Layout Close
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Rate Tables Rate: EX1 @
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Edit your material rates he & most current rates for each classification are shown.
To view the rates that were in Effect on dlfferent dates, change the effective date.

Show rates effective as of: | Oct-31-2024

Classification Resource Ef. Date Each
ol Wl
= Oct-31-2024
Record 1 of 1
0K Cancel Apply

By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.
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To add a new Material rate record, click the Add Row icon located in the ribbon bar. If you wish to
delete a record, elect it by clicking it once, and then click the Delete Row(s) icon located in the ribbon
bar. Click the drop-down list or the ellipses icon under the Classification column and select the
classification being assigned to the rate record.

Click the drop-down list or the ellipses icon under the Classification column and select the classification
being assigned to the rate record.

(\[eJ = Optionally, Billings supports rates for individual items by classification. If you choose to
enter a rate for an individual material in the classification selected, click the drop-down

list under the Resource column, and then select the individual material being assigned to
the rate record.

Select the Effective Date of the rate record (that is, when does this rate take effect) and enter in the
rates to be used for the earnings class (i.e., Each). Repeat these steps to add another classification to
this rate table.

1.13.1.6 Line Item Rates

To start entering Line Item rate information, click on the Line Item Rates tab under the Rate table tab
you are in. Continue adding the necessary resource type, classifications, and line item types for the
project and the corresponding rates.
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Edit your line item rates here. By default, the most current rates for each dassification are shown.
To view the rates that were in effect on different dates, change the effective date.

Show rates effective as of: | Oct-31-2024

Resource Type Classification Assigned To Line ltem Type Eif. Date Each
#0e e A0 e
= 2 Personnel Iron Worker - Jouneyman (IW-JM) Alowance - LOA Dec01-2023 20000 -
2 Personnel Iron Worker - Apprentice 1 {IW-A1) Alowance - LOA Jan-01-2023 150.00
2 Personnel Iron Worker - Foreman {|W-FM) AMlowance - LOA Jan01-2024 250.00
2 Personnel Premium - Confined Space 1.50
2 Personnel Premium - Fire Watch 50
2 Personnel 25
2 Personnel Allowance - Travel_Daily 100.00
2 Personnel Allowance - Travel_Shift Jan-01-2024 500.00
Record 1of 8
0K Cancel Apply

By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.

Edit your line items rates here.

To add a new Line Item (e.g. Premium or Allowance) rate record, click the Add Row icon located in the
ribbon bar. If you wish to delete a record, select it by clicking it once, and then click the Delete Row(s)
icon located in the ribbon bar.

Select the Resource Type in the first column (i.e., Personnel, Equipment, or Material) to indicate which
entity type the rate record will apply to.

Click the drop-down list or the ellipses icon under the Classification column and select the type being
assigned to the rate record. The list here will be determined by the Resource Type specified for the
row.

[\[e3g = Optionally, Billings supports rates for individual resources by classification. If you choose
to enter a rate for an individual resource in the classification selected, click the drop-

down list under the Resource column, and then select the individual resource being
assigned to the rate record.
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Select the Line Item Type in the next column (note that this list will be determined by your system
administrator during application configuration as it is configurable) to indicate which entity type the
rate record will apply to. Select the Effective Date of the rate record (that is, when does this rate take
effect) and enter in the rate to be used for the earnings class (i.e., Each). Repeat these steps to add
another row to this rate table.

1.13.2 Copying a Rate Table

In some cases, you will need to create a new rate table that’s very similar to an existing one. Instead of
performing the entire process of creating a new rate table, the best process would be to copy a rate
table.

COPY A RATE TABLE

1. Go to Project Administration > Rate Tables.

2. The Rate Tables tab appears. Select the rate table to be copied by clicking on it once with the mouse,
then on the ribbon bar, click Copy .

ql_-ﬂ(j'::.. R D x
[ -

° o o
T

= == R Kot @ e I
-

§ Paste
Addfow Delete  Refresh Sunde S PrintPreviem  SedTo  Import
Rawis) [5 Paste Specal & z =

3. Now click Paste or Paste Special to make a copy of the rate table.
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Paste creates an exact copy of the source rate table, while Special Paste lets you control what and how
the rate table is copied, including adjusting effective dates, changing rate table name, and code, and
adjusting other aspects of the rate table that are applicable for the new rate table. If Paste Special is
selected, the Paste Special window will appear

4. Under section 1, change the name of the rate table and type in an appropriate Code for the new rate
table.

Paste Special (Copy of # [Internal] Shop/Y.ard Facility - COST) x

5. Under section 2, determine precisely what portion of the rate table you want to be copied (either
Personnel, Equipment, Material, Line Items, or all four sets of rates).

6. Section 3 gives the choice of copying the rates exactly as they exist in the original rate table or to
modify the effective dates. If the effective date requires modification, choose the date the rates will be
effective from.

7. Section 4 determines the next steps, either to return you to the rate table list or open the new rate
table.

8. After the modifications have been made, click OK along the bottom of the rate table screen to save.

If Open the new rate table is selected, the new rate table will open allowing you to make any
additional modifications.

10. After the modifications have been made, click OK at the bottom of the rate table page to save.
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1.14 MANUAL RATE IMPORTS

The Manual Rate Import wizard will guide you through importing labor, equipment, material or line
item rates from a spreadsheet.

MeJg=0 To import multiple rate types, you must run the import wizard for each rate type

A custom template can be used to map and import data into the Billings rate tables. Template
spreadsheets are provided when accessing the wizard, but any Microsoft Excel spreadsheet can be
used and mapped through the wizard process. After the templates have been downloaded and ready
to import, click next to continue.

C ®=  xe = X
-

Welcome to the Manual Rate Import wizard

¥, @@F @ REB ¥

®®

IMPORT RATE TABLE FILE AND CONFIGURE SETTINGS

1. In the Rate table File section, select a file by clicking the ellipses, select the file, and then click open.
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- & x
HOME 2011 0
B —
C 3 Copy * Gt X
B Paste -
Refesh S Undo Citers Clos
Manual Rate Import ©
Step 1: Data Selection
Selectthe rate tabe i and corfigure setings
Rete Table Fie: =

Rate Table Type: @) Single rate perrow of data Multple: rates per row of data
Ignore the first rows(s) (R -

2. Columns from the imported file appear and can be updated in the Billings data selection screen.
After reviewing the imported data, click Next.

Manwal Rate Import ©

Step 1: Data Selestion
Select the rate table file and configure settings

Rate Table Fie: Ci\Users InEightDesktop! $25.3 Bilings*Rate Table Import - Labour Template xisx
Rate Table Type: @ Single rate per row of data Mutiple rates per row of data
Ignore the first rons(s Resource Type: [abour
Line# A B c D E F G H 1 J K L M N e}
1 Straight Time Ovetime Double Tir
2 Classiication Name Classfication Code Classfication Type Classfication Path Company Name Company Alas ~ Resource Source  ResourceCode  CustomerClass Code it Date Day Shit Night Shft DayShit  Night Shift Day Shit

3. The Column Mapping section lets you specify the column mappings. Fields with an asterisk are
required.

Click the matching line# drop-down (arrow/list) next to each resource to map the columns, and then
click Next.
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Step 2: Column Mapping
Specty the column mappings. Felds marked wih an astrisk (") are required

Linesit A B (= D E F (] H J K L M N (]

Match Classification Name: - e -
Match Clsssfication Code: Straight Time: Overtime Double Tin

oo :

- I i Comtnn Tpe | Gt | Comory o | Corpry o | Feson S| o o |GG | B st | Doy | e 5 Doy 4. g 5 0oy
Match Classfication Type .
Match Classfication Path -
Mateh Company Name
Match Company Alias
Match Resource Source:
Match Personnel Code
Custom Code Column
Effective Date Column
* Shift Column
* UOM Type Column
* Rate Column
Rate Code Column
cBack [ New> Cancel

4. Review and make any corrections in the Rate Table overview before you continue.

Only the records without errors are imported. To investigate errors, click the Log drop-down list. Click
the Backto fix any errors or Next to continue.

3 - i haadar Fars 4

a CalL

Line # Emor Msg Log Classification Mame Classification Code

- P —————— |1"| ............. Classification Code

CIassName Classification Mame
ClassCode: Classfication Code

Clags Type: Classification Type
EffectiveDate: Effective Date
ClagsPath: Classification Path

Finding compary |0 far CompanyAlias
Company Alias’ and CompanyMame
Company Name®

Rate table row key:
{"Class|D"null,"Lab DefID" null,"Equ
DeflD":null,"Mat DefID":null,"Linzftem 4

i ET AL | BRLI P PR D £ ELL e

QK Cancel

5. Select Create New Rate or Update Existing Rate Table to specify how to import the data, and then
click Next start your import.
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When creating a new rate table, label it in the Rate Table Name field. The Rate Table name, Rate Table
Code and Region fields are required to proceed.

Manual Rate Import ©

Import Rate Table
Please specify how to import the data. When you click "Next," we will start the import.
# Create New Rate Table I Update Existing Rate Table
Rate Table Name Rate Table Code
Default Effective Date | Apr-17-2025

Region

< Back Cancel

5. Click Next and then Finish to save your import.

1.14.1 Importing a Rate Table

Billings lets you create and maintain rate tables externally in a spreadsheet format and import the
rates into an existing rate table or as a new rate table. There are two forms of rate table imports.

You can use the Rate Import template through Processes > Imports > Rate Table Import or the Legacy

Labor Rate Import as shown below.

LEGACY LABOR RATE IMPORTS

e =0 Currently, Only Personnel rate import is supported
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1. To Start the import process, select Project Administration > Rate Tables and select Import Rates
from the ribbon bar.

2% C P e oo [ D

—
Add Riow  Dedste  Refresh = Unde & FrintPrevien SendTo | [mport
Rgrwr(s) = Rlates

2. The Rate Import wizard appears.

3. Select the spreadsheet file to import by using the ellipses (three dots) icon to launch the file picker
and select the path and the rate table Excel file.
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5. Specify whether the rates are stored horizontally or vertically in the spreadsheet and indicate how
many of the top rows to ignore (for example, header row which may contain column names). Click
Next to proceed.
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6. The second page of the wizard lets you map columns or rows in the spreadsheet to resource
classification, resource identifier (if required), and units of measure. The mappings are different
depending on whether the rates spreadsheet is horizontal, or vertical.

Single rates per row of data layout:

Multiple rates per row of data layout:
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7. After you have mapped the columns, click Next to go to the third page of the wizard which will
preview the imported rate table in Billings format.

8. The last column in the import preview page specifies errors that have been found with each line of
the import file. Only lines which are error-free will be imported into Billings. Review and correct any
errors reported and click Next to proceed.

9. The final page of the wizard lets you control whether the rate import will be imported into a new
rate table or whether the import will update an existing rate table.

10. Create a Rate Table Name or choose an existing rate table from the Rate Table Name drop down
list. If the Update Existing Rate Table option is selected. Indicate the Effective Date for the rates. After
you are done, click Import to import the rates.

1.14.2 Utilizing Mass Edit with a Rate Table

The Mass Edit feature is available to users to simultaneously adjust multiple rates within a rate table.
This function frees you from needing to adjust each rate individually. Although this functionality is
beneficial, you must be cautious when applying it, as multiple rate records are affected simultaneously.
The mass edit feature can also be used to clean up a rate table after it has been updated using the Rate
Import Wizard (for example, to remove any new rates that did not actually change from prior effective
date).
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MASS EDIT RATE TABLES

1. Go to Project Administration > Rate Tables.

3. The rate table opens in a new tab, with the General tab active below it.

Rabe Tables Rate Table ©

e sl Perfairres] Fates Esprnent Rates ey npnl B el
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4.Review the Personnel, Equipment and Material Rates tabs to confirm your selection is correct for
making mass edits. From the ribbon bar, select Mass Edit.

[ Mass Edit Rates

5. In section 1, select the type of mass update:

* Update Rates for the current Effective Date.

» Create new Rates for this Effective Date.

* Remove Rate lines (Classifications) for the current Effective Date.

* Remove Rates for the current Effective Date which have not changed since last Effective Date.

6. In section 2, determine precisely what scope of the rate table will be edited (either Personnel,
Equipment, Material, Line Items, or all four sets of rates).

7. In section 3, specify the adjustment details (gives the choice of blanking out the rates, keeping the
current rates, or altering the rates by either an amount or percentage).

8. After the modifications have been made, click OK to adjust the rate table based on the parameters
you specified. The adjusted rate table will automatically refresh with the effective date and rates
altered accordingly.

9. When complete, click the Apply button or to save the changes and exit the window, click OK located
at the bottom of the page.
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1.14.3 Configuring a Project

1.14 Manual Rate Imports

When a project has been created in Platform and flagged as being Time and Materials, it is

automatically synced into Billings.

To configure the project for billings purposes, double-click the existing project from the list and go

through the tabs listed below.

Name

WHc

“LEM Demo
ST-1001 TEST

LEM Demo 2

Import Testing

Test CBS Integration
DEMO - UNIT RATE
Piping Install Demao
Test

Bilings Demo Project

Record 0 of 9

x| |([Status] = "Active)

Code

111111.500
ST-1001
111111.500 2
IMPORT TEST
TESTCBS
DEMO-UR
Demao

1234

DEMO-BILL

Status
Active
Active
Active
Active
Active
Active
Active
Active
Active

Active

T  Intemal Code

Sample Ref #

Company

Default
Default
Default
Default
Defautt
Defautt
Defautt
Demo Supplier 2

Defautt

Region

Default
Default
Default
Default
Defautt
Defautt
Defautt
Defautt
Defautt

Edit Fitter

You can also manually create a new project by clicking the Add Row icon on the ribbon bar.

J[ell= A project created manually in Billings will not be automatically created in Platform.

1.14.3.1 Configure tab

To select bill rates, click the Bill Rate Table drop-down list, and then select the rate table that contains

the bill rates that apply to the project.
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Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Bill Rates

Select the default rates to be used in the invoicing of this project (and child WBS items).

Bill Rate Table: -
Allow Override Timesheet Bill Rate

Cost Rates

Selact the default rates to be used in the costing of this project (and child WBS items).

Cost Rate Table: .
Payroll Rates

Select the default rates to be used in the payroll of this project (and child WES items).

Payroll Rate Table: -
Work Flow

Set whether or not timeshests against this project (and child WBS tems) need to be approved prior to being invoiced.

Approval required

Budgeting

Set the level of detail of budgeting that will be used on this project. Once progress or budgets have been entered, you can no longer edit these values.

Budget By: -

Budget at Level: -
Custom Details

Dim 1:

Dim 2:

Activity Code:

OK Cancel
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress

Bill Rates

Select the default rates to be used in the invoicing of this project (and child WEBS items).

Bill Rate Table: -

oo e R
[Internal] Non-project Specific - COST
CostRates | [Internal] Shop/Yard Fadility - COST
Select the default rates to b 1varnal] Shop/Yard Fadility - PAYROLL
180002, Encana Pipestone Liquids Hub - BILLING

CostRate Table:
180002, Encana Pipestone Liquids Hub - PAYROLL
Payroll Rates | 180003, MEG - PAYROLL (Inactive)
Select the default ratesto b 13003, MEG Energy - BILLING (Inactive)
Payroll Rate Table: 180004, Encana TOWER 13-34-79-17 W6 PADSIT - PAYROLL
180005, Encana, Tower 6-16-080-17 W6 10 Well Pad - PAYROLL (Inactive)
Work Flow | 180006, Encana SCLH - BILLING (Inactive)
Set whether or not timesht 1506 Encana SCLH - PAYROLL (Inactive)
Approval required | 180008-33 -PAYROLL (inactive)
180009-33 - PAYROLL (Inactive)
Budgeting | 180010-33 - PAYROLL (Inactive) ~
— Set the level of detail of b x -
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Select the applicable job Cost Rate Table from the drop-down menu, if desired, and finally select the

applicable Payroll Rate Table from the drop-down menu, again, if desired or required.

Equipment

General

Bill Rates

Cost Rates

Payroll Rates

Work Flow

Budgeting

Custom Details

Payroll Rate Table:

Set whether or not timesh¢

Crew Material Timesheet Options Work Order Attachments Mobile Security
Configure Line Item Markups Cost Code Details/Notes Budget

Select the default rates to be used in the invoicing of this project (and child WBS items).
Bill Rate Table:

Allow Override Timesheet Bill Rate

Select the default rates to be used in the costing of this project (and child WBS items).

Cost Rate Table:

[Internal] EQUIPMENT - COST

[Internal] Non-project Specific - COST

[Internal] Shop/Yard Fadility - COST

Payroll Rate Table: [Internal] Shop/Yard Fadility - PAYROLL

180002, Encana Pipestone Liquids Hub - BILLING

180002, Encana Pipestone Liquids Hub - PAYROLL

180003, MEG - PAYROLL (Inactive)

Approval required | 180003, MEG Energy - BILLING (Inactive)

180004, Encana TOWER 13-34-79-17 W6 PADSIT - PAYROLL
180005, Encana, Tower 6-16-080-17 W6 10 Well Pad - PAYROLL (Inactive)
180006, Encana SCLH - BILLING (Inactive)

Budget By: 180006, Encana SCLH - PAYROLL (Inactive)

180008-33 - PAYROLL (Inactive)

Select the default rates to

Set whether or not timeshy

Set the level of detail of bu

Budget at Level:
180009-33 - PAYROLL (Inactive)
180010-33 - PAYROLL (Inactive)
Dim 1: =
Dim 2:
Activity Code:

OK

[Internal] EQUIPMENT - COST =

[Internal] Non-project Specific - COST
[Internal] Shop/Yard Fadility - COST

Approval required | [Internal] Shop/Yard Fadility - PAYROLL

180002, Encana Pipestone Liquids Hub - BILLING
180002, Encana Pipestone Liquids Hub - PAYROLL

Set the level of detail of bu

Budget By:

Budget at Level:

Dim 1:
Dim 2:

Activity Code:

180003, MEG - PAYROLL (Inactive)

180003, MEG Energy - BILLING (Inactive)

180004, Encana TOWER 13-34-79-17 W6 PADSIT - PAYROLL

180005, Encana, Tower 6-16-080-17 W6 10 Well Pad - PAYROLL (Inactive)
180006, Encana SCLH - BILLING (Inactive)

180006, Encana SCLH - PAYROLL (Inactive)

180008-33 - PAYROLL (Inactive)

180009-33 - PAYROLL (Inactive)

180010-33 - PAYROLL (Inactive) v

X

InEight Inc. | Release 25.5

Mobile Configuration

Cancel

Progress

Page 77 of 153



1.14 Manual Rate Imports Billings User Guide

If timesheet approvals are required for the project, check the Approval required check box. The main
result of this check box being set is that unapproved time sheets are not picked up for the LEM or
Invoicing process, or other exports which have time sheet approvals enabled.

W\[eJpa Work flow can also be handled at the processing stage of the time sheet cycle. If you are
generating a LEM process, the process can be set to the ignore approval work flow,
depending on your organizational work flow requirements.

Select the level of detail you want the budgeting information to use if you wish to track project
budgets in Billings. Most projects require more than one level of detail in the project structure. You can
track budgets and progress at the Project/ WBS level or at the WBS/Cost Code level, depending on
your budgeting requirements.

[\[e) 2 Project Level 1 means the budget is being created at the root project level. If set to
Project Level 2, the budget is being applied to WBS Level 1, second node of the project

tree.
Budgeting
Set the level of detail of budgeting that will be used on this project. Once progress or budgets have been entered, you can no longer edit these values.
Budget By: Project
Budget at Level: 2 .

1.14.3.2 Line-ltem Markups tab

In the Default Markup Values section, enter markup percentage values for your charge out rates for
Line Items that are entered on time sheets.

Page 78 of 153 InEight Inc. | Release 25.5



Billings User Guide 1.14 Manual Rate Imports

Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Default Markup Values

Line Items on timesheets will use the following markup percentages when calculating LEM amounts. Exceptions to these default percentages are specified in the table below.

Personnel line items are charged at cost plus %
Equipment line items are charged at cost plus %
Material line items are charged at cost plus %
Line items are charged at cost plus %
Other line items are charged at cost plus %

m | Invoice markups as seperate invoice items

Exceptions

The default percentages above may not be accurate for some of the resource type/line item combinations. Specify the exceptions here.

Personnel Equipment Material Line Items Other
Source
Line Item Type Subcontractor Employee DSP Third Party FAC
- Material
Expense
3rd Party

Transport & Freight
BURDENS - CPP
BURDENS -EI
BURDENS - Small Tool All...
BURDENS - Health

TEST

OK Cancel Apply

Default Markup Values

Line Items on timesheets will use the following markup percentages when calculating LEM amounts. Exceptions to these default percentages are specified in the table below.

Personnel line items are charged at cost plus %
Equipment line items are charged at cost plus %
Material line items are charged at cost plus %
Line items are charged at cost plus %
Other line items are charged at cost plus %

u | Invoice markups as seperate invoice items

Select the Invoice markups as separate invoice items if you want the markups to show on their own
invoice line, otherwise invoices will show fully marked-up amounts.
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In the Exceptions section, enter any markup exceptions that apply to specific line-item types. These
values are entered as percentages.

Exceptions

The default percentages above may not be accurate for some of the resource type/line item combinations. Specify the exceptions here.

Personnel Equipment Material Line Items Other
Source
Line Item Type Subcontractor Employee DSP Third Party FAC

- Material
Expense
3rd Party
Other
Consumables
Subcontractor
Equipment
Labour
Fuel
Transport & Freight
BURDENS - CPP
BURDENS - EI
BURDENS - Small Tool All...
BURDENS - Health
TEST

OK Cancel Apply

1.14.3.3 Cost Code tab

Click Add Rowon the ribbon menu to add new cost codes to the project/WBS node selected. Billings
only allows charging of time and resources to a project node if cost codes have been associated with
the project or WBS node. If your project structure is complex, you would normally not attach any cost
codes at the root node, as they would be defined at the lowest level of the project/WBS tree structure.

o = C (@) Copy X cut 14 sortBy Name Tl ><
AddRow Delete Refresh ©undo ShowActive |3 SortByCode Direction: Close
Row(s) Only Asc
Projects Project  ©
® add Q. Find Equipment Crew Material Timesheet Options Work Order Attachments Mobie Security Mobie Configuration
[ General Configure Line Item Markups Cost Code Detais/Notes Budget Progress
Cost Code Description
; -
Cost Code Desaription 2
<Add New Cost Code> | <Add New Cost Code>

00 Bilable

1020 Line Locating
1025 Hydrovac

If you need to remove a cost code, select the line, then click Delete Row(s) from the ribbon menu.
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Add as many cost codes to the node as needed to capture the required information during LEM data
entry. If the Project/Cost Code custom fields have been set up, you can populate them by clicking on
the small filter icon next to the cost code to open a list of the custom fields available.

1.14.3.4 Details/Notes tab

This tab lets you enter project specific data into custom fields that have been set up by the
administrator, along with general project notes.

Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Name Value

Travel Allowance Taxable?
Project Location/LSD

AFE No.

Client Ref. No.

[Company] Approval

Client Approval

Tax Code

Tax Rate

WBS Notes

Client Invoice Mapping

Apply time bumping

Time bump ST daily threshold
Time bump OT daily threshold
Time bump DT daily threshold
Time bump ST weekly threshold
Time bump stat holiday week threshold
Apply Site scope to time bumping
Time bump first day of week
Province Work Done In

Enable bill rate validation
Enable payroll rate validation

Enable cost rate validation

OK Cancel Apply

1.14.3.5 Equipment tab

Select the equipment filtering option that you want to apply to the project.

* No Filter lets you to select any active piece of equipment, given the Region security filters.
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e Filter by Site lets you to select only those pieces of equipment which have been associated with the

site to which the project belongs to.

e Filter by Schedule lets you to select only those pieces of equipment for which the work date falls

between the Start and End dates on the schedule page.

General Configure Line Item Markups Cost Code
Equipment Crew Material Timesheet Options Work Order Attachments
m Schedule assignment of equipment to this project and set the parameters to calculate its daily cost while assigned.
Pl

Specify how to filter the equipment list for timesheets entered against this project

{Filter by Schedule

Unit# Equipment Code Cost Classification = Start End Measure Daily Cost

afJc afJc afc afc = = afc =

Record 0 of 0

Details/Notes

Budget Progress

Mobile Security Mobile Configuration

OK Cancel Apply

When Filter by Schedule is selected, you can click Add Row to add equipment that is used in this

project .
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= = C (@) Copy % ot 14 sortBy Name Tl ><

B Paste
AddRow Delete Refresh ©undo ShowActive |1 SortByCode Direction: Close
% Only Asc

Add Row Project: ©

@ Add L Find General Configure Line Item Markups Cost Code Detais/Notes Budget Progress

] Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobie Configuration

a Schedule assignment of equipment to this project and set the parameters to calculate its daily cost while assigned
p

Spedify how to fiiter the equipment list for timesheets entered against this project

Fiter by Schedule

Unit# Equipment Code  CostClassification  Start End Measure Daily Cost
e e o = = rs =

Enter the assignment start and end dates as well as unit of measure and quantity to use in calculating
the daily equipment cost.

Moy g= The rate used in this calculation will be extracted from the Cost Rate Table set up for this
project on the Configure tab.

1.14.3.6 Crew tab

Select the personnel/crew filtering option that you want to apply to the project.
* No Filter lets you to select any active person from the personnel list, given the Region security filter.

* Filter by Site Personnel List lets you to select only those individuals who have been associated with
the site to which this project belongs.

e Filter by Selected Crews lets you to select only those individuals who belong to the crews selected in
the rows below from the crews defined for the site this project belongs to.
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General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
o If required, limit which crews may work on this project by adding them from the pre-defined site

wae aewlist.

Specify how to filter the personnel list for timesheets entered against this project

{Filter by selected crews

Code Name Type Notes Message

- oc o o o o

OK Cancel Apply

If Filter by Selected Crews is selected, select which crews will be working on this project by selecting
the Add Row icon located on the ribbon menu.

e g=0 Crews are defined at the Site level, which is identified in the General tab of the Project.

1.14.3.7 Material tab

Select the material filtering option that you want to apply to the project.
* No Filter lets you to select any active material from the material list, given the Region security filter.

* Filter by Site lets you to select only those materials who have been associated with the site to which
this project belongs to.
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e Filter by Materials lets you to select only those materials that belong to the materials selected in the
window below.

General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
l--- If required, limit which materials may be used on this project by adding them from the material

smm st

Specify how to filter the Material list for timesheets entered against this project

{Filter by Materials v

Code Name Region Company
Afc e afc afc

Record 0 of 0

OK Cancel Apply

1.14.3.8 time sheet Options tab

In the Multi Day time sheet, section set the number of days that will appear by default on a Multi Day
time sheet.
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General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
Multi Day Timesheet
Set the default number of days that will appear on a multi day timesheet (Max 31)
Days:

Timesheet Numbering
Use project specffic timesheet numbering

Start T/S# at:
digits

T/S# Template:

Prefix:

suffix:

Example:

The time sheet Numbering section lets you set up the prefix or suffix for the name you want to use in
the naming of your time sheets. It also lets you set the starting number and number of digits you want
to use. If you want to allow users to override the time sheet number, check the Allow user to override
T/S number option.

1.14.3.9 Work Order tab

You can add work orders that will be available on the time sheet page. To add a new work order, from
the Work Order tab, select the Add Row icon located on the ribbon menu. When the new row appears
on the page, provide all applicable information, then click Apply.
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General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
Code Description Start Date Close Date Client Contact Status HD Phase Code
e aQc = = a0c = alc

Record 0 of 0

OK Cancel Apply

1.14.3.10 Pay Items tab

Pay Items will be automatically populated from Platform if they have been defined. However, you can
also manually add pay items that can then be used on individual WBS items to group them for billing
purposes. To add a new pay item, from the Pay Items tab, select the Add Row icon located on the
ribbon menu. When the new row appears on the page, provide all applicable information, then click

Apply.
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General Configure Line Item Markups Cost Code Details Motes
Equipment Crew | Timesheet Options Work Order
Attachments Mobile Security Mobile Configuration Pay Items

Drag a column header here to group by that column p
Pay Item & Pay Item Description Status T

T e e = Active

o
Fixed Final Price Fixed Final Price Active
Time and Material Time and Material Active
Unit Price Unit Price Active

X |  Status = Active Edit Filter

o | o

Attachments tab

You can upload any pertinent documentation for this project on the attachments tab.
1. To add an attachment, click the Add Row icon located on the ribbon bar.

2. To delete an unwanted attachment, select the row to be deleted by clicking it once and then click
the Delete Row(s) icon located on the ribbon bar

3. After the new row appears, click the Folder icon in the new row in the Attachment column, to select
the document you want to upload.

Page 88 of 153 InEight Inc. | Release 25.5



Billings User Guide 1.14 Manual Rate Imports

General Configure Line ltem Markups Cost Code Details/Notes Equipment Crew
Material Timesheet Options Work Order Atachments Mobile Security Mobile Configuration Pay tems
Attachmert Type File Date Status

4. Locate the document in your folder structure, and then select it.

The attachment name shows in Attachment.

5. Select the type, file date and status from the columns, and then click Apply or OK.

After all the project tabs have been populated with the required information, you can create the WBS
structure.

1. To add a WBS item to a project, right-click the project, and then select Add WBS.

Alternatively, you can click the Add button, located directly above the project name to add a new WBS
item.

D Add Material Timesheet Options Work Order Atachments Mobie Securty Mobie Configuration Pay kems

General Configure Line kem Markups Cost Code Details/Notes Equipmert Crew
Postion Code Description

= - I “LEM Demo
UNASSIGNED UNASSIGNED ® Addwes o sl

. = Accounting Code 1 Collapse “ode: 111111.500
Accourting Code 2 biton

3 Insurance - Not incuded n Mark Up Cal —~ T EPand

C Bond Ca

SDI (511.50/51000) -

£=  Full Colapse

Sompany: Defaut
Bpand Tolevel i 7o:
Procare Charge

Tech Services Charge Colizpse To Level

2. Enter the name of the new WBS and the Code or abbreviation to be used for this item and the PO
number if required.

3. All other fields under the general tab are optional unless instructed otherwise by the administrator

or required for the job. If left empty, these fields inherit values from the parent node, or the parent’s
parent node.

Mo} = Unless a different set of rates needs to be used on this node than those set up at the
project node, nothing needs to be set up under the Configure tab. Rate table assignment
also follows the inheritance rules as above.
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4. To capture data on a time sheet against the project, cost codes must be applied to the project,

either at the project node (not recommended), or at the WBS nodes.

5. To apply cost codes, click the Cost Code tab of the applicable project or WBS node .

Cost Code

Description

Cost Code

<Add New Cost Code>
00

1005

1006

1015

1020

Description

<Add New Cost Code>
Billable

Survey

Dewatering

Grade

Line Locating

x

6. Click the Add Row icon located in the ribbon bar, then select the drop-down menu to choose the

cost code.

The Budget and Progress tabs are only visible if you specified budgeting configuration information at

the root node of the project in the Configure tab.

Equipment Crew

General Configure

Material

Timesheet Options

Line Item Markups

Work Order

Cost Code

Use the filter criteria and the button below to retrieve the sum of budgets for this project.

Show budget type: Progressive
Show budget effective as of: | Jan-30-2023 v Retrieve
Budget Item Cost Code
Equipment Crew Material Timesheet Options
General Configure Line Item Markups

4R Track the completion percentage for this project by date using the grid below.

Show progress effective as of:

Effective Date
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CostCode

Work Order

Cost Code

Attachments

Details/Notes

Qty

Attachments

Details/Notes

% Complete

Mobile Security Mobile Configuration
Budget Progress
Hours $ Amount
Mobile Security Mobile Configuration
Budget Progress
Units Installed
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7. In the Budget and Progress tabs, you can retrieve information on the selected job to view.
8. Click Apply to complete the setup of the node.

9. Continue to create additional WBS items and any child WBS items that are further required following
the steps above.

10. Using the Configure tab of a WBS item, select the applicable pay item that this WBS item belongs to
(this might be pre-populated from InEight Control if pay items are maintained there)

10. After all folder levels have completed, click OK to save the project and exit the page.

11. After all folder levels have been completed, click OK to save the project and exit the page.

"3 = To view the list of projects that have been set up, click on File, Open and Project.

1.14.4 Platform project association

You can associate Billings with additional master data, such as project data from the Project details
page in Platform. Associating Platform projects lets you organize Billings directly from Platform’s
Organizational Breakdown Structure (OBS). Your location assignment in the OBS determines the access
you inherit and your visibility to other OBS areas.

Extracting Platform project master data directly into Billings promotes data consistency and helps
ensure that the data is being pulled from a single source of truth.

Platform project-specific master data can be maintained in one place, then it can flow directly into
Billings in the cloud.
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Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration Pay ltems
General Configure Line tem Markups Cost Code Details/Motes Equipment Crew
a
Name: “LEM Demo
v Code: 111111.500
Paosition:
Company: i Default
Bill To:
Site:
PO #: Sample PO #

Internal Code: Sample Ref #

Division: -
Status: Active N
I Project: I -
OK Cancel Apply
= fd +LEM Demo|111111.500 / Project details DEMO(PTR2) @ L @ @

All projects & organizations >  Edit project DETAILS INFORMATION ATTRIBUTES

Project settings

Project details

* Project ID * External project ID @ Notes
111111.500 111111.500
+ * Name * Status
Add project image
*LEM Demo
Minimum of 540px x 360px Active M
*Phase @ * Organization

e ’ Aecount RootOraznizaten o

If the Billings project was created in Platform, the Project name, Code, and Position fields are disabled
and can only be managed in Platform.

1.14.5 Managing a Site

Sites are automatically created when a Project is created during synchronization with Platform. The
project’s name and code are used for the Site Name and Code fields. The purpose of sites is to
maintain project specific resources for use in Billings. The labor and equipment named resources, as
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well as vendors, assigned to the Project in Platform, are reflected in the Personnel, Equipment and
Companies tabs.

To view the list of all sites that have been set up, go to Project Administration > Sites. The available
columns on the Sites tab are as follows:

e Name
e Code
® Region

e Status

1.14.5.11 Personnel Tab

The Personnel tab shows the current resource assignments and is split into two sections, Assign People
and Create Crews.

If there are missing resource assignments that are required for billing purposes, and they cannot be
added to the project operational resources in InEight Progress , you can click Add Personnel to add
additional resource assignments. A window shows with the names of available people. Double-click on
each individual resource, or single select (highlight) all resources required and click OK. Once all
required resources have been added to the Personnel tab, click Apply to save the updates.
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Assign personnel to the site by using the 'Add Personnel' button. Once assigned, you can group personnel into crews, as well as
9 items related to this site to limit the timesheet personnel lists to this pre-assigned list.

[@ Add Personnel | X Remove Personnel

Code Last Name First Name Bill As Cost As shift ... Sync Status Order '.
T e aflc e e i alc o = = [

9 Personnel Resources

Code Last Name First Name Source Biling Clas... CostClassi... S.. Region Compan

T afc Afc alc Alc e ac ac Qe ac
s s Jan Jomo | oeane | oeae |0 dbets | coroan
1599 Witter Howard Emplo... TruckDriver = TruckDriver D... Alberta Compan
1761 Gerstel Crystal Emplo... Manager - ... | Manager -... D... Alberta Compan:
2338 Krawiec Ken Emplo... Executive ... | Executive ... D... Alberta Compan

X Vv Status = Active

Refresh OK

Record 0 of 0 «
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On the right side, you can further restrict who can work on any one project by creating site crews and
assigning personnel to each specific crew they are associated to.
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Create site crews and add personnel to them by dragging and dropping the personnel rows from the left side of the «
32 button. You can override the personnel attributes within a crew.

(® Add Crew X Remove Crew

Drag a column header here to group by that column

Code Name Type Notes
Y = Afc e = ac
P i ]
Record 1of 1
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Click the Add personnel button located above the Personnel tab to launch the Personnel List dialog
box. You can select multiple records using the mouse and holding the Ctrl key to select each applicable
record, or select a range of records by selecting the first record, holding the Shift key, and then
selecting the last applicable record. Click OK to bring the selected records to the page.

2 Personnel Resources m] X
0
Code Last Name First Name Source  Biling Clas... CostClassi... S.. Region Company Payro... . Y
T afc afc e Ac ac  afc afc afc = =
——mmm--mm
1761 Gerstel Crystal Emplo... Manager - ... Manager - D... Alberta Company ..  Act.
m_mm--mm
Thibault Emplo... Estimator - 1 Estimator -1 D... Alberta Company OnP Act..
_M_ME--ME!
2568 MacMullin Kevin Emplo... Superinten Superinten D Alberta Company OnP... Act.
E_——mm--m-
Sagert Laurence Emplo... Warehous... Warehous... D... Alberta Company nP Act
__EI-E-- one.. |
30019 Watts Clint DsP Welder -B ... Welder-B... D... Alberta DSP Comp... On P
30024 Anderson Barry DSP Constructi Construct D... Alberta DSP Comp OnP Act..
30027 Cross Brymer DSP Pipefitter -.. Pipefitter -.. D... Alberta DSPComp.. OnP.. @ Act. .
x v  Status Active Edit Filter
Refresh ‘ OK ‘ Cancel

After an individual is assigned to the site, additional details can be entered, such as timesheet entry
display Order, Site Code (usually customer driven), Shift Rotation, Start Date, End Date, and User Def 1-
4. The Shift Rotation is populated from the Personnel tab by default (if assigned on the global resource
record) but can be overridden. Shift Rotation selections are defined in the Options menu under the
Drop-Down List Setup, Shift Rotation Type.

You can override a worker’s default Bill and Cost Classifications while they are part of the
crew, by changing the Bill As and Cost As fields for the individual. These changes will be
the new default for time sheets when using these resources on a project, where the
project has the crew option enabled (Project Administration Project Crew Filter by
selected crews).

Use the right side of the page to create crew definitions for the site. Create crews by using the Add
Crew button, located at the top of the page. Enter the crew’s name and assign the crew a code, then
click Apply.
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o312 Anindividual can be part of multiple crew definitions at the same time. To view the
crew list, expand the crew definition by using the + button next to the crew code.

1.14.5.12 Equipment tab

The Equipment tab lets you view and maintain a list of equipment attached and assigned to the site.
User Def 1-4 can be set in the Site List. Select the Add Equipment button, located at the top of the page
to show the Equipment List dialog box. You can select multiple records using the mouse and holding
the Ctrlkey to select each applicable record or select a range of records by selecting the first record,
holding the Shiftkey, and then selecting the last applicable record. Click OK to bring the selected
records to the page.

Generdl | Aea | Persomel  Equpment = Material  Contact

e by using the 'Add Equipment’ button. Once assigned, you can configure project/WBS items related to this site to limit the timesheet equipment lists to this pre-assigned list

1.14.5.13 Materials tab

The Materials tab lets you view and maintain a list of material attached and assigned to this site. User
Def 1-4 can be set in the Site List. Click the Add Material button, located at the top of the page, to
bring up the Material List dialog box. You can select multiple records using the mouse and holding the
ctrl key to select each applicable record, or select a range of records by selecting the first record,
holding the shift key, and then selecting the last applicable record. Press OK to bring the selected
records to the page.
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Sites Site ©

General = Area  Personnel  Equipment  Material | Contact

smm  Assign material to the site by using the 'Add Material button. Once assigned, you can configure project/WBS items related to this site to mit the timesheet material lists to this pre-assigned list.
-
D AddMaterial | X Remove Materia
Code Name Region Company UserDef1  UserDef2  UserDef3  User Def4

T D e e o0 s o Al o0

15 Material Resources

Code Name Region Material Type  Biling Classification Status Y Company

= Active 0

T T S S TN LS T

x [v| | Statss = Active Edit Fiter

Refresh oK Cancel

Record 00f 0

1.14.5.14 Companies Tab

1.14 Manual Rate Imports

oK Cancel Apply

The Companies tab is used to assign companies to the site by using the Add Company button. When

assigned, you can configure project or WBS items related to this site to limit the timesheet company

lists to the pre-assigned list.

InEight Inc. | Release 25.5

Page 99 of 153



1.14 Manual Rate Imports Billings User Guide

one
C X

Refresh Close

Rate: EX1 Project: “LEM Demo Sites Site: Default ©

General Area Personnel Equipment Material Companies Contact

Assign companies to the site by using the 'Add Company’ button. Once assigned, you can configure project/WBS items related to this site to limit the timesheet company lists to this
pre-assigned list

(¥ Add Company | | Remove Company

Name Code Relationship Type UserDef1 UserDef2 UserDef3 UserDefd
Adc (= ]d e Adc Al Adc (= ]d

Record Oof 0

QK Cancel Apply

1.14.5.15 Contacts tab

The Contacts tab lets you view and maintain a list of contacts associated with this site. Click the Add
Contact button located at the top of the page, to add additional contacts to this list.
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General  Area | Personnel | Equipment = Material  Contact

s to the site by using the ‘Add Contact button.

1.15 TIMESHEETS OVERVIEW

1.1

5.1 Understanding TimeSheets

Timesheets get posted to Billings in the following ways:

Creation of a daily plan that is set to Approved

Creation of a weekly time sheet

Manual creation of a time sheet directly in Billings

Submission of a timesheet from the Billings Timesheet mobile app

External system that publishes billing related records directly into Billings via APIM feed

Time sheet import, where a user manually uploads a time sheet into Billings

Billings supports the following types of time sheets:

Single Day, Single Project
Multi Day, Single Project
Multi Day, Multi Project
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To view the time sheets tab and all time sheets that exist in the system, go to time sheets > time
sheets.

The available columns on the time sheets tab are as follows:
e Timesheet #
e Work Date
e Timesheet ID
e Job#
¢ Root Project
e Name
¢ Region
e Company
e Days
e Status
e Type
e Approval Status
e Close
¢ Created By
e Created Date
e Timesheet Total
e Modify By
¢ Modify Date
e Park

1.15.1.1 Time Sheet Status Rules

Timesheet and Approval

Timesheet Status Status Rules

Open All items contained on the time
sheet can be modified or
deleted, and new items will be
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Timesheet Status

Locked

Closed

Pending Approval

User Defined (optional)

Un-invoiced

InEight Inc. | Release 25.5

Timesheet and Approval

Status Rules

added if you have the
applicable security
permissions.

The time sheet contains items
that have been invoiced or
exported. Exported or
invoiced time sheet line items
cannot be modified or deleted
but new lines/items can be
added or modified by an
Administrator or Power User
until they too are invoiced or
exported.

Time sheet cannot be
modified

All items contained on the
Time sheet can be modified
or deleted and new items will
be added, providing the user
has security permission.

All items contained on the
Time sheet can be modified or
deleted and new items can be
added, providing the user has
security permission.

Time sheet cannot be
modified. Un-invoiced Time
sheet items will be eligible for
invoicing. Time sheet status
must be changed to Pending
approval or user defined
status to make any
modifications.

1.15 TimeSheets Overview
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Timesheet and Approval

Timesheet Status Status Rules

Parked Time sheet is temporarily
unavailable for exporting and
invoicing until Parked status is
removed. When Parked status
is removed, time sheet returns
to the status it had prior to
being parked.

CREATING A SINGLE DAY, SINGLE PROJECT TIME SHEET

1. To create a single day, single project time sheet, go to Timesheets > Timesheets.

Timesheets

Templates

2. From the ribbon bar, select the timesheet type by using the drop-down arrow on the New icon, and
select Single Project - Daily. A new Timesheet window opens.

- a X
HOME [m]
= @ c
=C F @ B ™ xa am FARO) @ X
New Delete Refesh Generate Viewlocks Create . OUndo @ PrintPreview SendTo  View: Al Layout Close
= | Rons) Line Items Tempate (B - - -
Single Project » Daily Edi Print Save | Filter Window A
Multi-Project > Weekly -
)
Timesheet £ Type Timesheet D 2b % Root Project Name Regon Company Work Date Days Status v
. # Closed
oo e o ot S — e —( e — T ——
0000019389 Single Day Timesheet 0000019389 Kennedy QA Test Kennedy QA Test(Ken. Alberta i Jectric & Cont. Jan-15-2023 1 Open
Copy 0f 0000019386 Single Day Tmesheet 0000019388 DEMO KIEWIT DEMODEMO) | Aberta Min Jan-14-2023 1 Open
0000019386 Sinale Dav Timesheet 0000019386 DEMO KIEWIT DEMO(DEMO) Alberta Minina Companv Jan-13-2023 1 Open
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3. Click the three dots icon located to the right of the Project field. A Project search display opens.

4. Find and select the Project that this timesheet is for by using the Project Root or Code drop-down
list.

Timesheets Timesheet - Single Day:  ©

Project: T/510: Ordered By
Region - | company: T/ #: Location Biled To:
Job #: Clent #
© Project =] X T/S Totak $0.00
ProjectRoot: | KIEWIT DEMO

Code: DEMO

Personnel  Equipment = Material  Lineltems = Detas Diary = #

Unit # Personnel Name Personnel G

oK Cancel

The project work breakdown structure (project tree) will appear in the main area of the Project display.

5. Select the applicable project folder by double clicking it. This returns the name of the folder selected
to the Project field on the Timesheet entry page.

[\eJ= Selecting a more detailed level of the project using the tree picker filters the available
project/cost code paths when entering Labor, Equipment, Material, and Line Items.

6. The project name will be filled in the Project field in the time sheet entry screen. The Region and
Client fields will default to the selected project’s region and client values (or those inherited from the
parent tree nodes of the selected project tree structure).

Project: KIEWIT DEMO(DEMO) T/SID: Ordered By:
Region: Aberta ~  Company: Mining Company T5# Location Biled To:
Division: - Job # Client #:

Date Jan-30-2023  ~ T/S Totak: $0.00
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7. If the selected project has been configured to use automatically generated Timesheet numbers, skip
to the next step; otherwise click on the Timesheet # field, and then enter the unique Timesheet
number for this Time sheet.

[\[s]J 2 You can leave the Time sheet # field blank, in which case the Time sheet # field is
automatically generated by the database and matches the system generated Time sheet
ID.

8. In the Date field, select the date when the work was performed.

T/SID: Ordered By:

TS = Location Billed To:

Job #: Client #:

Date: Jan-30-F3EE} T/S Totak $0.00

Monday, January 30, 2023

15 7 21
Cost Code - i - oT DT DTH

Clear

1.15.1.2 Personnel Tab

There will be several columns listed in the Personnel tab, as well as some columns hidden. However, to
speed up the process of data entry, it is beneficial to remove or add only the necessary columns.

If a column from the Personnel tab is needed on the Time sheet layout, you must add it before data
can be entered into it. Right click any column header, and then select Column Chooser to view this list.
You can then drag and drop any of the additional fields into the Timesheet view or remove any fields
that are not required.
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‘&, Group By This Column
4 Hide Group By Box
Hide This Column
= Column Chooser
ae BestFit
Best Fit (all columns)

Y Filter Editor

.00 .00 .00 .00 .00 .00 .00

(\[e]2 You can control where the new column will be displayed on the page by dragging and
dropping the column headers in the desired location, as identified with the black line.

After a layout has been created or modified with the columns relevant for data entry, save the layout
by expanding the Layout drop-down menu and then selecting Save As. A window opens, to allow you
to name the layout. This layout is specific only to you. It is not available to other users unless you or an
Administrator share it. After the layout has been saved, you can click Set Default, which makes it the
default view when you enter the Timesheet page in the future.

(\eJ = When creating a timesheet layout, keep in mind that multiple layouts can be created and
saved. It can be beneficial for the user to create a layout for when they are entering data

and another layout for when they are auditing the data entered.

After the layout has been modified, go into the Personnel field on the page and either begin typing the
last name or use the drop-down menu to pull up a list of personnel.
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Personnel | Egupment ~ Material  Lineltems  Detals = Diary = Attachments

Unit 2 Personnel Name Persomel Code Bl As Cost As shift Cost Code: st or ot OTH ™ LoA Day
 E— - I I N [N N A [ S
Name Code Classification  Classification ... Region Status &
Aaron Brewst... 176689 KC_Labourer ... KCABSR Aberta Active
Aaron Frick A 103391 KC_Welder - KC-wDCwWB Aberta Active
Aaron Pearso... | 135800 KC_Labourer .. KCABSR Aberta Active
Aasen Mchael 30998 PE-M Aberta Active
Ababio El 31038 PF-M Aberta Active

i 174112 r ... KCABSR Alberta Active

AbdiHussein | 30937 PF-IM Alberta Active

.00 .00 .00 .00 .00 .00 .00

Record 10f 1

The Bill As, Cost As, and Shift fields automatically populate with the default values specified for the
person selected. However, if the person whose time is being entered is to be billed out or cost as
another classification, the Bill As or the Cost As field(s) can be changed to the appropriate personnel
classification to ensure the time sheet is invoiced and cost coded appropriately. For example, if a
Journeyman is promoted for a day, since it is a temporary change to the classification, the Bill As field
can be changed as needed on a single timesheet line/item without changing the person’s default
classification.

1.15.1.3 Cost Code Field

Press the Tab key to go to the Cost Code field. Click the drop-down to display a list of cost codes
defined for the selected project node (and any child WBS items). How the project is set up determines
how the cost code list is shown.

Personnel  Equpment  Material  Lineltems Detals = Diary = Attachments

LoA Day

st or oT DTH ™

Unit Personnel Name Personnel Code  Bil As CostAs shift Cost Code

Cost Code

2672/2875/2914/2924/1005

A= The list of cost codes is embedded in a project path. This path is created by following the
folder levels of the WBS structure so that the costs are allocated to the proper area. For

example, if the path is 1/EXT/PIP/11.01, this means that the costs are going to Plant 1,
Extraction Area, Piping, and Cost Code 11.01.
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The next set of fields determines the billing type for the units. Dependent on the project contract,
Personnel can be billed out for ST, OT, DT, DTH, TT, Day, and LOA.

If multiple personnel are being used for the job, click on the Add Row icon located on the ribbon bar to
add a row, or use the Tab key to move all the way to the right of the page and press Tab again to
generate a row.

el =0 Billings automatically copies most of the information from the previous row to a new
row. To remove a row, click the Delete Row(s) icon located on the ribbon menu.

1.15.1.4 Equipment and Material Tabs

Perform similar steps to enter equipment on the Equipment tab, and materials on the Material tab.
Both Equipment and Materials that appear from the drop-down list will be filtered if the project that
the time sheet is being charged against has been set up to filter the Equipment or Material lists.

Personne i Egupment Materidl Lneltems = Detsis  Dary Attachments

Unit # Equipment Bil As Cost Code

Code Measure Quantity
g0 umroeon 1 ™ S E

1.15.1.5 Line Items Tab

When there is data that needs to be entered, but it does not fall within the predefined units of
measure on the Personnel, Equipment, or Materials tabs, you can enter it on the Line ltems tab.
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Personne | | Equpment = Material Lieltems  Detals Diary = Attachments

Line Item Assignment Details

Re... Assgnedto Source Description Type Measure Quantity Rate Amount | Attachment Attachment Fie Date

PO # Cost Code
| ] N [ N N R I R N N

0.00 $0.00

The Line Items tab offers the flexibility to enter any other items that are related to the time sheet that
do not neatly fall into the predefined categories of Personnel, Equipment or Materials. This can include
expenses, premiums and allowances, surcharges, rental fees, or other additional fees that are related
to the time sheet. If required, a line item can be assigned to a person (e.g., small tools allowance,
equipment rentals, other premium, etc.), a piece of equipment (such as., repairs, additional charges),
material (such as, a hauling charge), or entered as an Other line item.

The Line-ltem tab lets you:
¢ Allot a Custom Description to the item
e Charge it to a cost code (required)
e Attach it to an applicable PO #
¢ Assign a unit of measure
¢ Track the quantity

¢ Key the rate instantaneously

1.15.1.6 Details Tab

The Details tab lets you capture any field notes associated with the time sheet and also enter data into
any custom time sheet fields set up by the application administrator.
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personnel | | Equpment Materidl Linetems Detals Diary = Attachments

Exdude From Time Re-Allocation

Additional time sheet details can be captured in the Diary tab.

Personnel | Egupment ~ Material  Lineltems  Detals Diary | Attachments

Did any of the Crew experience an injury today that was not reported? If so, please describe

X-tra Work Performed Equipment Damage
Cost Impacts Other Observations
Incidents

Did any incidents occur today that need to be reported? If so, please describe. Iecs

What other information s relevant to support noted items from the Daily Diary Checklist?

When you're done entering data into the time sheet, click on Apply or OK.

1.15 TimeSheets Overview

a3l The Park and Close fields affect time sheets that need to be put on hold or closed.

To view the Time sheets tab and all time sheets that have been created, select Timesheets >

Timesheets.

The available columns on the time sheets tab are:
e Time sheet #
e Work Date

¢ Time sheet ID

InEight Inc. | Release 25.5
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e Job#

¢ Root Project

* Name

e Region

e Company

e Days

* Status

* Type

e Approval Status
e Close

e Created By

e Created Date

e Time sheet Total
e Modify By

¢ Modify Date

e Park

CREATING A TIMESHEET LAYOUT

1. Right click any column header and select Column Chooser to view this list.

You can then drag and drop any of the additional fields into the time sheet view or remove any fields
that are not required.
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21 Sort Ascending

Z1 Sort Descending
Clear All Sorting

I Group By This Column

4° Hide Group By Box
Hide This Column

= Column Chooser

+A+ Best Fit

Best Fit (all columns)

Y Filter Editor...
Show Find Panel
Show Auto Filter Row
Filter Mode >

My Column Caption

(\[e3g= You can control where the new column will be displayed in the grid by dragging and
dropping the column headers in the desired location. You can also select My Column

Caption to rename the column headers.

2. After you have created a layout with the columns relevant for data entry, you can save the layout by
selecting the Layout drop-down from the top right side of the tool bar.

3. Click Save As.

The Save Layout As dialog box opens, and you can name the layout.

This layout is specific only to the user logged into Billings. It will not be available to other users unless it
is shared by the user or an Administrator.

4. After the layout has been saved, the user can select Set Default which will make it the default view
when they access the Timesheet page in the future.
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mE X

Layout Close

-

Save As...
System Default
Set Default

Remove Default

InEight Billings X

Save Layout As...

OK Cancel

1.15.2 Creating a Multi-Day, Multi-Project TimeSheet

CREATE A MULTI DAY, MULTI PROJECT TIME SHEET

1. To create a multi-day, multi-project time sheet, go to Timesheets > Timesheets.
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Timesheets

Templates

2. From the ribbon menu, click the New icon, and then select Multi-Project > Daily. A new Timesheet
window opens.

<< [
H=C % @

New Delete Refresh Generate View Locks
v Row(s) Line Items

Single Project »

Multi-Project » Weekly

3. Click the Timesheet # field and enter in the number of the time sheet.

e3g= You can leave the Timesheet # (T/S) field blank, in which case the Timesheet # will
automatically generate from the database and will match the system-generated
Timesheet ID.

4. Click the Start Date drop-down arrow and select the starting date of the time sheet (that is, the first
day the work was performed or the first day of the shift).
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TS ID: Job #: Ordered By:

s # Start Date: Feb01-2023 ~ Location Biled To:
Region: Payrol (EMP &DSP) ~ | Number of Days on T/S: 53 Client #:
Division: ~ | Company:

5. Adjust the Number of Days on Timesheet if needed.

6. Click the three dots icon next to Company field to select the client this work was done for.

Timesheet - ) o
TSID: Job #: Ordered By:
TS Start Date Feb-01-2023 ~ Location Biled To:
Region: Payroll (EMP &DSP) ~ | Number of Days on T/S: 5 3 Client #:
Division: - | company: =

Thu Feb-02-23
Personnel | Code Personnel Name: Bill As - LOA DAY ST or oT DTH s LOA DAY ST or
R I
Name Code Relationship Type Status Y
e e e = Active A
N - R S
SemCAMS ULC 1063 Client Active
Ovintiv Canada ULC 1031 Client Active
Canadian Natural Resources Limited 1061 Client Active
x v Status Active: Edit Filter
Refresh [ oK ] Cancel

1.15.2.7 Personnel tab

The Personnel tab includes columns that might normally be hidden. To speed up the process of data
entry, it is beneficial for you to include only the necessary columns.

1.15.3 Creating a Multi Day, Single Project Timesheet

CREATE A MULTI DAY, SINGLE PROJECT TIME SHEET

1. Go to Timesheets >Timesheets

2. From the ribbon menu, click the New icon, and then select Single Project - Weekly.
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Timesheets Timesheet - Single Day:  ©

Project: DEMO(DEMO)

Region: Aberta

Division: -
Personnel ~ Equipment  Material  Lineltems  Detais Diary

Did any of the Crew experience an injury today that was not reported? If so, please describe.

Did any incidents occur today that need to be reported? If so, please describe.

What other information is relevant to support noted items from the Daily Diary Checklst?

Park Close  LastCreated /S #:

~ | Company:

Attachments

TSI:

Mining Company

Job #:

Date: Jan-30-2023

Safety Concerns.
Work Performed
X-tra Work Performed
Cost Impacts
Schedule Impacts

Lessons Learned

Weather Conditions

Temperature

Ordered By:

Location Biled To:

Conversations W/ Owner
Visitors to Site
Equipment Damage
Other Observations
Incidents

Injuries

1.15 TimeSheets Overview

| New TS after Apply [<3 Cancel Apply

3. Click the elipses icon located to the right of the Project field and select the project that this time

sheet is for by using the Project Root or Code drop-down list.

Timesheets Timesheet - Single Day: @

Project: KIEWIT DEMO(DEMO)

Region: Aberta -
Division: -
Persomnel | Equipment = Material  Lineltems = Detals Diary | #

Did any of the Crew experience an injury today that was not reported? If so, |

Did any incidents occur today that need to be reported? If so, please describe

What other information is relevant to support noted items from the Daily Diary

Park Close  Last Created T/S

InEight Inc. | Release 25.5

T/SID:
Mining Company 5%
Job #:

ProjectRoot: | KIEWIT DEMO

DEMO

Name.

[ KIEWIT DEMO(DEMO)

BMT Burnaby Mountain Tunnel(1892)
> | 57Spread 7(2672)

> | ST Sumas Terminal(3052)

oK Cancel

Ordered By:
Location Billed To:
Client #:

T/S Total: $0.00

Conversations W/ Owner
Visitors to Site
Equipment Damage
Other Observations
Inddents

Injuries

| New TS after Apply oK Cancel Apply
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4. The project name is auto-filled. The Region, Division, and Company fields are automatically
populated based on the project selected.

Project: DEMO(DEMO) T/SID: Ordered By:

Region: Aberta ~ | Company Mining Company T/ #: Location Biled To:

Division: - Job # Gent #:

Date Jan-30-2023  ~ /S Totak: $0.00

5. If the selected project has been configured to use automatically generated time sheet numbers, skip
to the next step. Otherwise, click on the Timesheet # field and enter in the number of the timesheet.

{2 You can leave the Timesheet # field blank, in which case the value in the Timesheet #
field is automatically generated by the database and matches the system-generated
Timesheet ID.

6. Select the starting date of the time sheet (that is, the first day the work was performed or the first
day of the shift).

T/SID: Ordered By:
TS #: Location Billed To:
Job #: Client #:
Date: Jan-30-EiFE T/ Totalk: $0.00
Tuesday, January 31, 2023
8 January 2023 »
SU MO TU WE T™H FR SA
2 3 4 5 6 7
8 9 10 11 12 13 14
15 16 17 18 19 20 21
Cost Code oT DT DTH
22 23 24 25 2% 27 28
29 n 31
Clear

7. Adjust the Number of Days on the time sheet if needed.

The Personnel tab includes columns that might normally be hidden. To speed up the process of data
entry, it is beneficial for you to include only the necessary columns.
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The Bill As, Cost As, and Shift fields automatically populate with the default values specified for the
person selected. However, if the person whose time is being entered is to be billed out or cost as
another classification, the Bill As or the Cost As field can be changed to the applicable personnel
classification to ensure the time sheet is invoiced and costed appropriately.

For example, if a Journeyman is promoted for a day, since it is a temporary change to the classification,
the Bill As field can be changed as needed on a single time sheet line or item without changing the
person’s default classification.

Press the Tab key to move to the Cost Code field.

Click on the drop-down arrow to display a list of cost codes defined for the selected project node (and
any child WBS items). How the project is set up determines how the cost code list shows.

The next set of fields is used to capture the quantity of hours worked per type of hours. Depending on
the project contract, personnel hours can be recorded against ST, OT, DT, DTH, TT, Day, and LOA.

If time for multiple persons is being used for the job, click on the Add Row icon located on the ribbon
bar to add another row, or use the Tab key to move all the way to the right of the page and press Tab
again to generate a row.

e = Billings automatically copies most of the information from the previous row to a new
row. To remove a row, click on the Delete Row(s) icon located on the ribbon menu.

If you are entering the same data for multiple personnel rows, it is more efficient to use the multiline
entry dialog box than manually entering individual rows. The multiline entry dialog box lets you select
several personnel records and apply same cost codes, quantities, and units of measure to these rows in
one step. If you select multiple cost codes, multiple rows are created for each personnel record and
cost code record selected.

1.15.3.8 Equipment and Material tab

You can follow the same functionality to enter equipment on the Equipment tab, and materials on the
Material tab that you followed for the Personnel tab.

InEight Inc. | Release 25.5 Page 119 of 153



1.15 TimeSheets Overview Billings User Guide

Persomnel | Equpment | Material | Lineltems Detais Dary Attachments
jel
Unit # Equipment Code Bil As Cost Code Measure Quantity

[ N S L 2 e 1 S E

Record 10f 1

Some columns are normally less used so they must first be added to the Timesheet layout before data
can be entered into them. Right-click any column header, and then select Column Chooser to view this
list. You can then drag and drop any of the additional fields into the Timesheet view or remove any
fields that are not required.

J[elg= You can control where the new column displays on the page by dragging and dropping
the column header to the desired location.

Persomnel | Equipment  Material | Lineltems = Detals ~Diary = Attachments

yel
Unit Personnel Name

Bil As CostAs shift Cost Code st

¥ Darcannal Cada or oT DTH T LOA Day

Sort Descending

N N2

" Group By This Column

T Hide Group By Box

Hide This Column

Column Chooser
+a+  BestFit
Best Fit (all columns)
Y Filter Editor.
Show Find Panel
Show Auto Filter Row
Filter Mode >

My Column Caption

.00 .00 .00 .00 .00 .00 .00
Record 10f 1

1.15.3.9 Line Items Tab

The Line Items tab offers the flexibility to enter any other items related to the timesheet but that do
not neatly fall into the predefined categories of Personnel, Equipment or Materials. This can include
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expenses, surcharges, premiums, allowances, or other additional fees that are related to the time
sheet.

If required, you can assign a line item to a person (for example, small tools allowance, or equipment
rentals, premium, or allowance), a piece of equipment (for example, repairs or additional charges),
material (for example, hauling charge), or entered as an Other line item.

Personne i Egupment = Materidl Lneltems = Detsls  Dary Attachments

Line Item Assignment Details

Re.. Assgnedto Source Description Type Measure Quantity Rate Amount | Attachment Attachment Fie Date

PO # Cost Code

0.00 $0.00

The Line-ltem grid lets users:
¢ Allot a Custom Description to the item
e Charge it to a cost code (required)
e Attach it to an applicable PO#
¢ Assign a unit of measure
e Track the quantity
¢ Key the rate instantaneously

e Track the item against Project Commitments (See Assigning Commitments to Projects section of
this guide)

Right click any column header and select Column Chooser to view this list. You can then drag and drop
any of the additional fields into the time sheet view or remove any fields that are not required.

ey g= You can control where the new column will be displayed in the grid by dragging and
dropping the column headers in the desired location.
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zl
il

NOTE

Sort Ascending

Sort Descending

Clear All Sorting
Group By This Column
Hide Group By Box
Hide This Column
Column Chooser

Best Fit

Best Fit (all columns)
Filter Editor...

Show Find Panel
Show Auto Filter Row
Filter Mode »

My Column Caption

option. If you wish to use the default name, blank out the custom name.

Billings User Guide

Right click on the column header that you wish to rename and select My Column Caption

Once you have created a layout with the columns relevant for data entry, save the layout by selecting

the Layout drop-down from the top, right side of the tool bar. If this is a new layout, select Save As. If

you are saving changes to an existing layout, select Save.

1.15.3.10 Details tab

On the Details tab, you can capture any field notes associated with the time sheet, and enter data into

any custom timesheet fields set up by the application administrator.

| | Equpment Material Lineltems Detals Diary = Attachments
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You can capture additional time sheet details on the Diary tab.

Personnel | Egupment ~ Material  Lineltems  Detals Diary | Attachments

Did any of the Crew experience an injury today that was not reported? If so, please describe. Safety Concems Conversations W/ Owner
Work Performed Visitors to Site
X-tra Work Performed Equipment Damage
Cost Impacts Other Observations
Schedule Impacts Incidents

Did any incidents ocaur today that need to be reported? If o, please descrbe. ] e

Weather Conditions

What other information is relevant to support noted items from the Daily Diary Checkist?
Temperature

Upon completion of time sheet data entry, click Apply or OK at the bottom right of the page to save
your changes.

Park Close  Last Created T/S #: V |New TS after Apply oK Cancel Apply

Me)g= The Park and Close fields affect time sheets that need to be put on hold or closed.

CREATING A TIME SHEET LAYOUT

1. Right click any column header on one of the timesheet grids and select Column Chooser to view a
field list.

You can then drag and drop any of the additional fields into the time sheet view or remove any fields
that are not required.
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21 Sort Ascending
Z1 Sort Descending
Clear All Sorting
I Group By This Column
4° Hide Group By Box
Hide This Column
=| Column Chooser
+a+ BestFit
Best Fit (all columns)

Y Filter Editor...
Show Find Panel
Show Auto Filter Row
Filter Mode >

My Column Caption

[\[s] 2 You can control where the new column will be displayed in the grid by dragging and
dropping the column headers in the desired location. You can also select My Column

Caption to rename the column headers.

2. You can control where the new column shows on the page by dragging and dropping the column
headers to the location.
You can also select My Column Caption to rename the column headers.

3. After you have created a layout with the columns relevant for data entry, you can save the layout by
selecting the Layout drop-down from the top right side of the ribbon bar.

4. Click Save As.

The Save Layout As dialog box opens, and you can name the layout.

This layout is specific only to the user logged into Billings. It will not be available to other users unless it
is shared by the user or an Administrator.

5. After the layout has been saved, the user can select Set Default which will be the default view when
they access the Timesheet page in the future.
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mE X

Layout Close

Save As...
System Default

Set Default

Remove Default

InEight Billings X

Save Layout As...

OK Cancel

Mo = When saving a layout, it is best practice to modify all the tabs (that is, Personnel,
Equipment, Material, and Line ltems) that will be used in the specific layout being saved.

6. After the layout has been modified, click into the Personnel Name field on the page and either begin
typing the resource last name or use the drop-down list to pull up a list of personnel resources.
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When entering time sheets into Billings, it is time effective for you to use the Tab key to
move from column to column. When using the Tab key at the end of the last row, Billings
automatically creates a new row and jumps to the first column in the new row, copying
values from the last selected row.

To view the Timesheets tab and all time sheets that have been created, go to the menu list and expand
the Timesheets option, then select Timesheets.

1.15.4 Copying an Existing Timesheet

You can copy an existing time sheet by following these steps:

COPY EXISTING TIMESHEETS

1. Go to Timesheets > Timesheets.

Timesheets

Templates

2. Select the time sheet to be copied by clicking it once. If the timesheet you are looking for is not in
the list, type in the time sheet number in the Timesheet # field to search for it. If you still cannot find
the timesheet in the initial list, you may need to click the “Refresh” button on the ribbon bar to
retrieve more matching timesheets from the database.
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:X C ¢ a @ X ot G Print D) @ IE'X

New Delete Refresh Generate Viewlocks Create OuUndo (S PrintPreview SendTo  View: All Layout Close
= Row(s) Line Items Template 8] - - -
Actions Edit Print San Filter Window N
Timesheets ©
o)
je
Timesheet # Type Timesheet ID Job # Root Project Name Region Company Work Date Days Status Y
s = o o o o o o = = # Closed .
0000019390 Single Day Timesheet 0000019390 DEMO KIEWIT DEMO(DEMO) Alberta Mining Company Jan-17-2023 1 Open
0000019389 Single Day Timesheet 0000019389 Kennedy QA Test Kennedy QA Test(Ken. Aberta Techmation Electric & Cont. Jan-15-2023 1 Open
Bl cory of 0000019386 | Sigle Day Timesheet | 000001388 | | oemo | xaEwrT oemo(EMO) | Aberta | Mining Company | san-14-2023 | 1] open
0000019386 Single Day Timesheet 0000019386 DEMO KIEWIT DEMO(DEMO)  Aberta Mining Company Jan-13-2023 1 Open
HOME
— (B Copy - =
=C F @ B Kot @t ® m X
New Delete Refresh Generate Viewlocks Create OuUndo 3 PrintPreview SendTo  View: Al Layout  Close
&~ Row(s) Line Items Template D < < &
Actions Edit Print Save Filter Window -
Timesheets © M
x [[searcr Fod_|
Timesheet # Type Timesheet ID Job # Root Project Name Region Company Work Date Days Status A4
T - L L L L L L - - # Closed

3. Click Copy from the ribbon bar.

4. Click Special Paste

Jle =0 Ensure Special Paste is selected and not Paste as Special Paste lets you control how the
copy process is performed.
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Paste Special (Copy of T/S# 0000019389) X

1. Choose the type of copy you wish to make:

e Copy (makes a new unlocked copy only);

Credit (makes a credit timesheet only)

Adjustment (make| Y)
: b Caredit (makes a credit timesheet only) i)p,

2. Enter timesheet details:
Credit T/S #:

New copy of Timesheet:

TS # Copy of 0000019389
T/S Date: Jan-15-2023 v
Copy the following values from the original:

v |Hours and Quantities
v | Line Items

v | Timesheet Notes
GPS Location

To remove from the newly created copy:
Inactive Employees
Inactive Equipments

Inactive Materials
3. Pressing OK will copy the timesheet and:

® Return you to the timesheet list Open the new timesheet

OK Cancel

5. In section 1, choose the type of copy you want to make.

6. Section 2 automatically names the time sheet as “Copy of”, plus the original timesheet number.
Change this to the new time sheet number if needed. Select the work date for the new timesheet. This
section also contains the options of having the hours, quantities, line items, and time sheet notes pull
in from the original timesheet it was copied from.

7. In section 3, select Open the new time sheet.

8. Click OK. The new time sheet opens. You can modify the time sheet as required with any
information that needs to be changed.
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1.15.5 Importing a Timesheet

Billings lets you import multi-project or multi-day time sheets from a spreadsheet if the correct

template is used.

IMPORT A TIME SHEET

1. Processes > Imports > Timesheet Import.

A
Actuals Task Transfer Adjustment
Retro Rate Adjustment
5
Rate Table Import
Timesheet Import

Legacy Labour Rate Imports

*o0 Process Status

[y
T

E Job Schedule

The time sheet Import window opens.
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- 8 x

HOME m]

B =C = X

Create Delete Refresh Layout Close
w(s) -

Import  Row

Timesheet Import  ©

[(j Using imports allows you to import a file from other applications into DTC.

Created Descrif iption Create By Status
- = - o
11/202: port LEM: 19383 Completed
4/2023 Ti LEM: 19375 Completed
/4/2023 Ti port LEM: 19374 Completed
Record 10of 4

2. Click the Create Import button. The Import Definition dialog box opens, and you can specify the file
containing the timesheet data that you want to import. Billings previews the file contents in the time
sheet Header, Personnel, and Line Items tabs.
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[¥ 1mport Definition O X

e Name: Timesheet Import

Enter Criteria:
Import Timesheet Source Excel File: C:\Users\Crystal.Gerstel\Desktop\Time..

Submit OK Cancel Apply

3. You can edit the data in the import window in Billings to correct any errors that are reported. After
you have corrected the errors, click OK to revalidate the data. This lets you correct errors in the import
file without having to edit the file itself.

1.16 LEMS

1.16.1 Creating a LEM

The standard Billings LEM process is called LEMs, which stands for labor, equipment and material
reports. When selecting a project via the Project tab and managing the criteria, the criteria screen has
two tabs, General and Project. Both need to be populated.
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CREATE ALEM

1. Go to LEMs > LEMs.

The LEMs tab opens, listing all results previously generated LEMs.

HOME
O]
= C &m mE X

Create Delete Refresh (3 printPreview Layout Close
Process  Row(s) -

LEMs ©
D) Using exports allows you to save system data as a fle. This fle can then be imported into other appiications to remove the need to double enter data and reduce entry errors
el
Created Desaription Created By Status
T oD 0 0 =
41 LEM # 190010103 - 0003 ( Crystal Gerstel Approved
[ Kennedy Rouiston Pending Approval
Kennedy Rouiston Pending Approval
Crystal Gerstel Pending Approval
202209-09 09:46:32 Crystal Gerstel Pending Approval
202209-09 09:46:32 Crystal Gerstel Pending Approval
2022:09-09 09:46:32 Crystal Gerstel Pending Approval
2022-09-09 09:46:32 Crystal Gerstel Pending Approval
2022-09-09 09:46:32 Crystal Gerstel Pending Approval
2022-09-09 09:46:32 Crystal Gerstel Pending Approval
20220909 09:46:32 Crystal Gerstel Pending Approval
2022:09-09 09:46:32 Crystal Gerstel Pending Approval
20220518 15:06:07 Crystal Gerstel Pending Approval
20220518 14:55:54 Crystal Gerstel Pending Approval
202205-18 12:04:17 Crystal Gerstel Pending Approval
202205-18 12:01:17 Crystal Gerstel Pending Approval
20220518 11:50:53 Crystal Gerstel Approved
202205-18 10:54:12 LEM # DEMO - DEMO1 (23673) Crystal Gerstel Pending Approval
2021-12:09 13:54:20 LEM # 180004 - RETRO RATE AD) SAMPLE (23660) Crystal Gerstel Pending Approval

2. To review the contents of a particular LEM, or for LEMs that require approvals, select the applicable
result, and then double-click to open the LEM in its own LEMs Detail tab.

J[el1 2 Depending on the process type, the Notes section can contain information regarding the
outcome of the process. The contents of the resulting Details page varies by each process

type.
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3. If the LEM has not yet been approved, you can review the detailed results and remove any lines that
should not be approved. After reviewing results, you can then approve the LEM, which in turn locks the
underlying data from future edits.

LEMs LEMs Detail @ -
Notes:
=3 This Export hss ot yet been spproved. To mrk it =5 spproved, set the Status to Approved and fil in the export’ Date Accepted
value. Marking an export as approved is a permanent action and wil make this record read-only. Marking an export as approved
camnotbe undone.
Description:  LEM # DEMO - DEMO# (23695)
Criteria:
Created:  5/18/2022 2:55PM Status: Pending Approval - N
Modified:  5/18/2022 2:56 PM Date Accepted: -

Detail | Attachments

TSID  Proj.. | Proj.. Proj. Proj. |Proj.. WBS.. Wor.. T/S# TSI  T/SJ). Reso. Reso.. Reso.. Type |Reso.. Shft | Cust. Cust.. BilA. BIA. Cost. Cost. Lne.. Line.. WES.. Cost. UOM | Qty  Mark.. Mark. BIIR.. BilA. TSL. T/SCom

~ 18333 DEMO KIE 05/0.. DEM.. 18338 3RD .. Linel Ape. Mate 360- 00 EAL 1000 10.0. 36.8. 368.. 405 dParty +
18338 DEMO | KIE 05/0.. DEM.. 1833 D .. Linel fpe.. Mate 380 00 EAL | 1000 100. I1S8. 15. 174 dparty
18338 DEMO | KIE 05/0.. | DEM.. | 18338 | RD .. Linel fpe. Mate 360- 00 EAL | 1000 100. B8.241 824. 906 Hdparty
18338 DEMO | KIE 05/0.. | DEM.. | 18338 | RD .. Linel fpe. Mate 360- 00 | EAL | 1000 100. 287. 7. 316 Hdparty
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Ape. Mate 360- 00 FT 2.000 10.0. 17.6. 83.0. 183. 3rd Party
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Ape. Mate 360 00 FT 0.100  10.0 0.880 83.0. 9.680 3rdParty
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Alia. Mate 00 EAL 1.000 10.0 10.5. 105. 116. 3rdParty
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Alia. Mate 00 EAL 1.000 100 3.15 315 34.7. 3rd Party
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Allia. Mate 6374 00 EAL 1.000 1520  19.2 211 3rd Party
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Willy'... | Tran. 1804. 00 Ls 1.000 0.000  75.3. 75.3. 3rd Party
18338 DEMO  KIE.. 05/0. DEM.. 18338 | RD Linel. Ape. Mate 360-... 00 EAL 1.000 10.0. 9.425 942 103, JrdParty
18338 DEMO  KIE.. 05/0. DEM.. 18338 | RD Linel. Ape. Mate 360-... 00 EAL 1.000 10.0.. 2500 25.0. 27.5. JrdParty
18338 DEMO  KIE.. 05/0. DEM.. 18338 | IRD Linel. DNO. Cons. 9136... 00 EAL 1.000 6.000 0670 1LL 118, FrdParty
18338 DEMO | KIE. 05/0. DEM. 18338 | 3RD Linel. DNO. Mate 9136. 27415 | 2672. 00 EAL 1.000 100 13.4. 134 147. FrdParty
18338 DEMO  KIE 05/0.. DEM.. 18338 WD .. Linel DNO... | Mate o136 %720 00 EAL | 1000 100. 134. 134.. 147 srdparty
18338 DEMO | KIE 05/0.. | DEM.. | 18338 | RD .. Linel Alia.. | Mate 6374 00 EAL | 1000 W0. 123. 123. 135 srdparty
18338 DEMO | KIE 05/0.. | DEM.. | 18338 | RD .. Linel Russ.. Mate 6034, 00 FT | 200. 0. 110. 550 121 Hdparty
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Ape. Mate 360- 2872, 00 EAL 1.000 10.0 3.757 | 37.5. 413 3rd Party
18338 DEMO  KIE. 05/0. DEM. 18338 | 3RD Linel. Ape. Mate 360 2872, 00 EAL 1.000 10.0 159  19.9. 21.8. IdParty

68.1.. 354... 305... 2,88.. 350.

Record 10f 38

oc Cancel Apply

4.You can create a layout for the LEMs Detail page by selecting the Layout drop-down list on the right
side of the ribbon bar.

5. Depending on the process, you can send the process results to a report or send the data to a file
using the export-specific buttons at the bottom of the page. See the Report Export Options topic for
more details on viewing the export details as a report.
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mg X

Layout Close

Save As...
System Default
Set Default

Remove Default

InEight Billings X

Save Layout As...

OK Cancel

6. After you have reviewed or approved the export, click OK or Apply to save your changes and exit the
page. If you want to cancel your changes, click Cancel.

7. To initiate a new instance of a LEM, select the Create Process icon located on the ribbon bar.
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LEMs LEMs Criteria ©

eneral * | Project

Enter Filter Criteria:

8 The LEMs Criteria screen opens with the General tab selected. This tab lets you set the LEM
parameters that control the scope of the data that will be processed by the LEM process.

9. Use the Project tab to specify a specific job, or specify individually selected WBS items for a single
job to limit the scope of the data processed by using the Limit Scope To section of the screen.

10. Click the Submit icon located on the ribbon bar when you are done setting the parameters and
want to initiate the LEM process.

To check on the progress of your request, go to the Process Status page (Processes > Process Status).

To see your new request listed on the LEMs tab, click the Refresh icon located on the ribbon menu.

1.17 INVOICES

1.17.1 Creating an Invoice

An invoice records the transaction between a buyer and seller, and establishes the terms of payment.
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CREATE AN INVOICE

1. Go to Invoices > Invoices.

The Invoices tab opens with a list of all previously generated invoices.

= C am m X
Create Delete Refresh (@ printPreview Layout Close

Process  Row(s)

Actions Print Window

Invoices © =
D) Using exports allows you to save system data as a fie. This file can then be imported into other applications to remove the need to double enter data and reduce entry errors
jeo)
Created Description Created By Status
T e o0 o =

- EwRE 00000101 o)

2. To review the results of a particular invoice process, or for invoices that require approvals, select the
applicable result, and then double-click to open the invoice process in its own Invoices Details tab.

Invoices Invoices Detail © -
Ij) This Export has not yet been approved. To mark it as approved, set the Status to Approved and fillin the export's Date Accepted ot
value. Marking an export as approved is a permanent action and wil make this record read-only. Marking an export as approved
cannot be undane.
Description:  DEMO - DEMO1 (23703)
Criteria:
Created: 5/18/2022 3:21PM Status: Pending Approval - Override Invoice Num: DEMO1 B
Date From: May-01-2022
Modfied:  5/18/2022 3:21PM Date Accepted: - Date To: May-18-2022
Invoice Date: May-18-2022 v
Detail | Attachments
0
T/SID  Project... Project.. Project.. Project.. Project.. WBSLL. T/Sob.. Resour.. Resour. Resour.. Type  Resour.. Linelte.. Custom. BlASC.. BlAsN.. CostAs.. CostAs. WBSPa.. UOM Qty Markup.. Markup.. BilRate Bl Amo.. GeneratedL
= 18334 DEMO  KIEWI. PROGR.. labour 150597 Ewing,.. Subcon.. DSPCo Welder .. KCWD.. KCW.. KCWD.. Welder.. 26722.. ST 8.000 54990  439.920 B
18334 DEMO | KIEWIT PROGR... Labour | 119926  Cooper.. Subcon.. DSPCo. Labour... KCABR |~ KCLla. KCABEL Labour.. 26722.. OT 5.000 45.070  225.350
18335 DEMO | KIEWIT PROGR.. Labour | 111295  Hedn,.. Subcon.. DSPCo Carpen.. KCCP1  KCCa. KCCP1  Carpen. 26722. ST 10.000 33.430  334.300
18333 DEMO | KIEWIT PROGR.. Labour | 180681  Gerace.. Subcon.. DSP Co. Welder ... | KC-WD... | KC_W.. KC-WDBP Welder.. 2672\2.. DT 10.000 120.000  1,200.
18335 DEMO | KIEWIT PROGR.. Labour 69590  Callend.. Subcon.. DSPCo. Carpen.. KC-CP3  KCCa.. KCCP3  Carpen.. 26722 OT 2.000 83.000  176.000
18335 DEMO | KIEWIT PROGR.. Labour 69590  Callend.. Subcon.. DSPCo Carpen.. KC-CP3  KCCa. KCCP3  Campen. 26722. OT 2.000 59730 119.460
18334 DEMO | KIEWIT PROGR... Labour | 106145  Stefiuk.. Employee | Kiewit- Labour.. KCABSR |~ KCLla. KCABSR Labour.. 26722.. ST 10.000 54210 542.100
18335 DEMO | KIEWIT PROGR.. Labour | 135545  Vienne.. Subcon.. DSPCo. Carpen.. KC-CP1  KCCa.. KCCP1  Carpen. 26722. ST 5.000 33430 167.150
18335 | DEMO | KIEWIT PROGR.. Labour 129630  Lakhan. Subcon.. DSPCo Carpen.. KC-CP4  KCCa. KCCP4  Campen. 26722. ST 10.000 49.600  496.000
18335 DEMO | KIEWIT PROGR... Labour | 117891  Middet.. Subcon.. DSP Co. Carpen.. KC-CP2  KC_Ca.. KCCP2  Campen.. 26722.. OT 2.000 52400 104.800
18334 DEMO | KIEWIT PROGR... Labour | 50320  HolmM.. Subcon.. DSPCo. Superin.. KC-SUP  KCSu. KCSUP  General.. 26722. OT 10.000 125670 1,25.
18334 DEMO | KIEWIT PROGR... Labour | 150597  Ewing,..  Subcon.. DSP Co. Welder .. | KCWD... | KC_W.. | KC-WD... Welder .. 2672\2.. OT 2.000 74390 148780
18335 DEMO | KIEWIT PROGR... Labour | 135545  Vienne.. ' Subcon.. DSP Co. Carpen.. KCCP1  KCCa. KCCP1  Carpen.. 26722.. ST 5.000 33.430  167.150
18335 DEMO | KIEWIT PROGR.. Labour 69590  Callend.. Subcon.. DSPCo. Carpen.. KC-CP3  KCCa.. KCCP3  Carpen.. 26722. ST 8.000 44.210  353.680
18335 DEMO | KIEWIT PROGR.. Labour | 117891  Middet.. Subcon.. DSPCo. Carpen.. KCCP2  KCCa.. KCCP2  Carpen. 26722.. ST 10.000 38.820 | 388.200
18334 DEMO | KIEWIT PROGR... Labour | 119926  Cooper.. Subcon.. DSPCo Labour... KCABR ~KCLla. KCABEL Labour.. 26722.. ST 5.000 33430 167.150
18335 DEMO | KIEWIT PROGR.. Equpm. 55429  Welder .. Owned Weldin... | KC-WD. KC-WD... | Welder .. 2672\2.. HR 10.000 15,000 150.000
18335 | DEMO | KIEWIT PROGR... | Equpm.. 55721 | Welder w Weldin... | KC-WD. KCWD...  Welder .. 2672\2.. HR 10.000 13.000  130.000
18340 DEMO | KIEWIT EQPAD... Equpm.. 54887  Welder.. Owned  Kiewit- Weldin... | KC-WD. KC-WD... | Welder ... 2672\2.. HR -10.000 15.000 | -150.000 .
183.000 10.000  4.000 31,803... 42,834...
Record 10f 48
oK Cancel Apply

3. If the invoice has not been approved, you can review the results on the page and remove any lines
that should not be approved. After the results have been reviewed, you can then approve the invoice,
which in turn locks the underlying data from future edits. After you have reviewed or approved the
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export, click OK or Apply to save your changes and exit the page. If you want to cancel your changes,
click Cancel.

CREATE A NEW INVOICE

1. To initiate a request to generate one or more invoices, click the Create Process icon located on the
ribbon menu

C om B X
Create
Proce:

Refresh & print Preview Layout Close

1]

2
2

elete
)

=%

The Invoices Criteria tab opens with the General tab selected. This tab lets you set the invoice
parameters that control the scope of data that will be processed by the invoice process.

Invoices Invoices Criteria  ©

General* | Project | Process

Enter Filter Criteria:

2. Use the Project tab to limit the process scope to one or more jobs; if only one job selected, you can
use the Limit Scope To section to further the generation of the invoice(s) to specific WBS or Pay Items

3. Use the Process tab to limit scope of the invoice generation to only specific LEMs (for example, only
Approved but un-invoiced LEMs to be included)

4. Click the Submit icon located on the ribbon menu when you are done setting the parameters and
want to initiate the invoice process.

5. To check on the progress of your request, use the Process Status page (Processes > Process Status).

To view your new request on the Invoices tab, click the Refresh icon located on the ribbon menu.

1.18 MANAGING MASS CHANGES
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1.18.1 Retro Rate Adjustment

Billings lets you reverse locked timesheets to process various adjustments, such as retroactive rate
changes. The adjustment process generates locked credit time sheets that back out the previously
locked time sheet information and create new timesheets with refreshed rates. The new timesheets let
you to perform further edits before using the newly generated timesheets for LEMs, invoices or other

system processes (exports).

START A RETRO RATE ADJUSTMENT

1. Select Processes > Adjustments > Retro Rate Adjustment or Actuals Task Transfer Adjustment.

Timesheets

Templates

Actuals Task Transfer Adjustment

Retro Rate Adjustment

The appropriate Adjustment tab appears for the adjustment process selected.
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B =C m X

Create  Delete Refresh Layout  Close
Adjustment  Row(s) -

Retro Rate Adjustment ©

L\y Using adjustment processes allows you to system generate credit and adjustment LEM entries for timesheet entries that have already been locked.
Created Description Created By Status
"0 a0 a0c =
3- Retro Rate (¢ Kennedy Roulston Completed
Retro Rate (¢ administrator Completed

Completed
Completed

Completed
administrator

Completed

RetroRate (i administrator Completed

2022-09-22 10:03:20 RetroRate (i administrator Completed

2022-09-2208:54:16 administrator Completed
Completed
Completed

Completed

Completed

2021-12-09 12:15:46
2020-03-0707:59:47

Completed
Completed

2020-02-1108:07:54 Retro Rate (14229) rystal Gerstel Completed

2. Select the Create Adjustment icon.

B =C m X

Create Delete Refresh Layout Close
Adjustment Row(s) -

The adjustment selection criteria dialog box opens. This dialog lets you set the filtering and adjustment
specific parameters which will control the scope of the data selected for adjustment and any output
formatting of data by the adjustment process. The filtering parameters and control parameters are
unique to each adjustment process type.
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< |
B =C m X

Create Delete Refresh Layout Close
Adjustment  Row(s) -

Retro Rate Adjustment ©

: pp  Usaadustmentprocessesalows you tosystem generate recit and adustment LEM entries for tmesheet entris thathave aready been locked
Created Description Created By Status
e e e -
2230104210029 et Rate_TEST VIORK ORDER (84410)
2023-01-03 14:32:01 Retro Rate (84387) Kennedy Roulston Completed

Retro Rate (34378) administrator Completed
RetroRate (i administrator Completed
RetroRate (i administrator Completed
RetroRate ( administrator Completed

Completed

Completed

20; :20 Completed
2022-09-2208:54:16 Completed
2022-09-22 08:52:45 administrator Completed
2022-09-22 08:49:02 Completed
2022-05-18 15:04:40 Completed
2022-05-18 12:14:53 Completed
2021-12-09 12:15:46 Completed
2020-03-07 07:59:47 Completed
2020-02-1108:07:54 Completed

3. Click the Submit icon located on the ribbon bar when you are done setting the parameters to initiate
the adjustment. A dialog box opens indicating the process was submitted.

InEight Billings X

o Process has been submitted. Please use the Refresh button to check the result after the process done.

oK

4. To check on the progress of your request, use the Process Status screen (Processes - Process Status).

To see your new request on the Retro Rate Adjustment tab, click the Refresh icon located on the
ribbon bar.
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1.18.2 Generate Timesheet Line Items Wizard

It might be necessary to generate multiple time sheet line items based on a set of project rules. The
Timesheet Line-ltem Generator lets you create a time sheet with line items that are based on results of
calculations based on entered set of criteria.

GENERATE TIME SHEET LINE ITEMS

1. From the Timesheets page, click the Generate Line Items icon on the ribbon bar. The Generate Line
Iltems wizard opens.

HOME
0
= C [I n @ ?cow KXot B Pt D) ® @ ><

New Delete Refresh Generate Viewlods Create Sndo @ PrintPreview  SendTo  View: Al Layout  Close
~ Rows) Line Items Template o > N

Actions Edit Print Save Filter Window

2. Click Next to continue.

Timesheets Generate Timesheet Line Items  ©

Generate Timesheet Line Items

This wizard willalow you to set parameters to generate a timesheet which wil contain calculated line items based these parameters.

Note: Day rate units are not induded in the incentives calculations.

To continue, dick Next

3. Select the type of calculation logic you need to use for the line item generation and click Next. Select
one of the following options.
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Timesheets Generate Timesheet Line Items  ©

Line ltem Parameters
Spedify the type of calculation to use

The e items are generated based on a set of calcuation rues. You must speafy which set
of rules you wish to use to generate these e items:

Set amount per hour worked
Set amount per hour worked by type of time (ST, OT, DT, DTH, TT, LOA)
Set daily amount if hours worked for that day exceed set threshold

Set daily or weekly amount based on daiy and weekly minimum hours rules

<Back Next > Cancel

e Set the amount per hour worked — Calculates amount by multiplying total labor hours within a
specified time by a preset hourly amount.

Timesheets Generate Timesheet Line Items  ©

Line ltem Parameters

Spedify calculation detals

‘The Dollar Per Hour calaulation type wil apply the rate spedified below to each and every hour worked
by an indvidual during the specified data range and for the speified project(s)

Please spedfy the amount of ine item to be generated per each hour worked: $hr
Indude Travel Time (TT) in calculation

Indude Living Out Alowance (LOA) in calaulation

<Back [ Next> | Cancel
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e Set amount per hour worked by type of time — Calculates the amount by multiplying various Labor
hour totals grouped by unit of measure by a preset hourly amount set per type of time. Type of time
refers to the Labor unit of measure (i.e., ST, OT, DT, etc.).

Timesheets Generate Timesheet Line Items O

Line ltem Parameters
Spe: jon details

e Set the daily amount if hours worked for that day exceed set threshold — Calculates a daily amount if
the total Labor hours for that day meet or exceed a preset threshold.
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Timesheets Generate Timesheet Line Items O

4. Set daily or weekly amount based on daily and weekly minimum hours rules — calculates amounts
based on day of week threshold hours rules. If Labor hours meet or exceed all daily thresholds then the
weekly amount applies, otherwise daily amounts are calculated for all days that meet or exceed the
daily thresholds. For days that do not meet the daily threshold, hourly amount applies.

For this calculation type, the date range is specified with a starting date and an indicator
as to how many full weeks of data to use as source for the calculations.

NOTE
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Timesheets Generate Timesheet Line Items  ©

5. Click Next to begin specifying the time sheet criteria to base the calculations on. The criteria include
project(s), time sheet and time sheet Approval Status, and time sheet Work Date range. After you have
specified the filters click Next.
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Timesheets

Generate Timesheet Line Items  ©

Line ltem Parameters
Spedify source data for calculation

Projects

Please select the project or projects for which the i items should be generated.

v <AlProjects>
“SAMPLE BUDGET PROJECT (190013) - 15-30 Separation Fadiity - Field Construction(190013)
*SAMPLE PROJECT (180002) - Pipestone Liquids Hub, Fadiity Construction(180002)
*SAMPLE PROJECT (190010) - AWTF Electrical Construction(190010K104)
*SAMPLE PROJECT (190010) - AWTF Pipeiine(190010K110)
“SAMPLE RETRO-RATE AD) PROJECT(180004)
“SAMPLE TASK TRANSFER PROJECT (190012) - 15-30 Separation Fadiity Fabrication & Assembly(190012)
“SAMPLE WO PROJECT (190010) - AWTF General Constructon(190010103)
[INTERNAL] Estimating - 2020(200000)
BL Project Name(BL Project Code)
Import Root Project(IMPRC2)
Import Root Project(IMPRC2_CSV)
Kennedy QA Test(Kennedy QA Test)
KIEWIT DEMO(DEMO)
QA test 2(QA test 2)
QA test(QA test)
SAMPLE PROJECT - 14-30-071-08 W6M Compressor Plant(180011)
SAMPLE PROJECT - E~406 Stainless Valve Replacement(200005)
SAMPLE PROJECT - Fabrication & Assembly(180015)
SAMPLE PROJECT - Field Pipe Fabrication(200006)
SAMPLE PROJECT - Shop Fabricated Pipe & Fittings(190008)
SAMPLE PROJECT - Stainless Steel Spools(200002)
SAMPLE PROJECT - Tower Stabilzer Feed Bottom Exchanger (200001)
TEMP(TEMP)

Timesheets

Indude timesheets that are: |/ | Al Timesheets, or: | | Approved Locked Pending
e et Jan-30-2023 +| to | Jan-31-2023 ~

6. Select personnel filters, if any, and click Next.

Billings User Guide

<Back Next> || | Cancel

Meyg= Only projects with assigned personnel will let you filter by person.
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Timesheets Generate Timesheet Line Items  ©
Line ltem Parameters

Select Personne!

Select "All Personnel", or spedify individuals for whom the line items should be generated. By default, line items wil be generated for all individuals.

Note: If any of the selected projects do not require pre-assignment of personnel, all personnel for those projects wil be induded in the calculation.

Name Code

<Al Personnel>

Specify personnel status for the line item generation. By default, lne items will be generated for active as wel as inactive individuals.

V| Active Employee v Inactive Employee

7. The generated line items will attach to a newly created time sheet. In this step, provide details about
the time sheet header as well as the generated time sheet Line Items, and click Next.

J[elg= The Roll up calculated values to a single line-item option lets you summarize all
generated line items to a single line item on the generated time sheet. This is a single line

item that will not be associated with any personnel records.

InEight Inc. | Release 25.5 Page 147 of 153



1.18 Managing Mass Changes Billings User Guide

Timesheets © Generate Timesheet Line Items O

Line ltem Parameters
Spedify generated ti

imesheet details

heet. Please supply values for the various details of the generated

8. Review your criteria and click Next.

(\[eJ= The criteria preview content will copy to the Notes field of the generated time sheet.

9. The final step of the wizard displays the calculation results. Clicking the Finish button will open the
Timesheet page with the generated time sheet.

feyp= The generated time sheet is not actually created in the database, and you will need
to click Ok or Apply on the time sheet page to save it to the Billings database.

1.18.3 Viewing Timesheet Locks

Timesheets can be locked by multiple processes in the system. The ability to understand which
processes have locked a specific time sheet record is often helpful in troubleshooting a solution to fix a
record that has been incorrectly captured. For example, if a time sheet record has been locked by a
LEM process, but the LEM has not been issued to the client, then deleting the LEM process with that
time sheet record on it lets you modify the record, as it becomes unlocked after the process has been
deleted. However, if one or multiple processes have locked a record, and they cannot be deleted, then
any adjustments must be handled through an adjusting process.
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VIEW TIME SHEET LOCKS

1. Go to Timesheets > Timesheet.

2. From the Timesheets tab, select the time sheets you want to view, and then select the View Locks
icon located on the ribbon bar.

- o

= &
= C F g B "™ xa sm 3 ® m X
New De{e(h:) Refresh L?en:;::: View Locks CYE;;EE & B “uUndo S PrintPreview SendTo  View: All Layout Close
s e e = . E -

Actions Edit Print Save Filter Window

©  Timesheet - Singl

Timesheet # Y Type Timesheet ID Job # Root Project Name: Region Company Work Date Days Status Y
T o = o0 o o0 # Closed .
—@—m_-m-
N S T S I U TS = = = N [T
e - = = = =
oo [sveowmweret  Jomosm | [we  [emoonon [wwe  [wwown  Deoss | low |
e L L N L e v e N S

0000019384 Single Day Tmesheet 0000019384 180002 *SAMPLE PROJECT (1.. | Aberta Ovintiv Canada ULC Jan-11-2023 1 Open
0000019383 Single Day Tmesheet 0000019383 180002 *SAMPLE PROJECT (1. | Aberta Ovintiv Canada ULC Jan-10-2023 1| Open

3. A new tab opens listing the selected timesheet with the following columns available for cross
referencing:

e T/SID

e T/SH#

e T/S Start Date
e T/SType

e Approval Status
e T/S Status

e Parked

4. From the T/S ID column, click the plus (+) icon to view the selected timesheet results. The T/S Items
tab opens with a list of all timesheet records within the timesheet selected.
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m X

@ c
C ®  xe
Refresh  Undo Layout  Close
Actions Edit Window ]
Timesheets Timesheet - Single Day: 0000019389 Timesheet Cross Reference ©
TS s Y | T/SStartDate T/SType Approval Status /S Status Parked
T e = 0000019385 e e o e e
- [+ owoms omses Foporit e mepest I S
Record 10f 1
Edit Flter

x [v| T/5# = 0000019385

5. Double-click the timesheet item you want to view to see which processes have locked or consumed

that timesheet item.
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Timesheet - Singl © Timesheet Cross Reference

Project BL Project Code (BL Project Name) T/SID: 0000019385 Ordered By:

Region: Aberta ~ | Company: SemCAMS ULC TS5 # 0000019385 Location Billed To:

Division: Field Construction - Job #: Client #:
Date Jan-11-2023  ~ T/S Totak: $816.30

Personnel  Eguipment  Material  Lineltems Detals Diary Attachments

Unit 2 Personnel Name Personnel Code Cost As shift Cost Code st LoA Day

Bil As or oT DTH m
EERS - N S oo e e Y ") I N I [ I —

Record 10f 1

Multi Line Entry. Park Close oK Cancel Apply

1.19 REPORTS

1.19.1 Report Export Options

Click the Send To menu option located on the ribbon bar at the top of the page, and then select either
Grid or Pivot Grid. Depending on which report is opened, the Excel option can only be used when the
report has first been exported to a grid or pivot grid.

If Grid is selected, the report data is pushed to a spreadsheet-like grid that lets you group, filter and
sort the data and create basic mathematical group functions like summing, counting, averaging, etc.

Grouping is done by dragging a column header to the grey box located at the top of the window.
Sorting is done by clicking on a column header. The first click sorts the data in ascending order, and the
second click reverses the order.

You can use the first row of the data to apply filters to the data shown within the grid. Alternatively,
you can use the quick filter, by clicking on the small funnel icon located on the right hand side of every
column. This will show you a selectable list of values to filter.
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All other functions are accessed through the Customization menu by right clicking on a column to bring
up the Customization dialog box.

As with all other Billings grids, you can create and save custom layouts for the grid and pivot grid
reporting views. After a layout has been created with the relevant columns, you can save the layout by
selecting Layout from the top, right side of the tool bar.

Jleag= Filters and sort order is also saved with the layout.

If Pivot Grid is selected, there are five view options to select from and more than one of these options
can be selected at the same time.

Show Column Grand Totals Show Column Totals

Show Custom Totals for Single Values Show Grand Totals for Single Values
Show Row Grand Totals Show Row Totals

Show Totals for Single Values

As with the Grid report, the data is displayed in a spreadsheet pivot- style, and it can be manipulated
by dragging and dropping the columns around the page. You can customize the results by applying
filters to headers, add or remove displayed columns using the customization pop-up menu, rename
columns and saving layouts with these changes.

If Excel is selected, an Export to Microsoft Excel Document dialog box opens. Choose the destination
the file should save to, and then click Save.

When the file is opened, you can edit or adjust the report as required through the Excel spreadsheet.

Click the Close button to exit any of these reports. This will return you to the Report List grid.

1.19.1.1 Print Preview

Click the Print Preview icon located on the ribbon bar. If only one report is assigned to the process you
are reviewing, the report will open by default. If there are multiple report options, a window will open
listing all available reports. You can then double click on the desired report to open.

C & Print I:j E ><

Refresh @3 prntpreview  SendTo Layout  Close
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